This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2012 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
Contact CA Technologies

Contact CA Support

For your convenience, CA Technologies provides one site where you can access the information that you need for your Home Office, Small Business, and Enterprise CA Technologies products. At http://ca.com/support, you can access the following resources:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

Providing Feedback About Product Documentation

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

To provide feedback about CA Technologies product documentation, complete our short customer survey which is available on the CA Support website at http://ca.com/docs.
Contents

Chapter 1: Introduction ............................................................. 11
   About this Guide .................................................................. 11
   CA Clarity PPM Training and Training Tools ...................... 11
   Quick Tour of CA Clarity PPM ........................................... 12
      Main Menu ..................................................................... 13
      User Toolbar ................................................................ 14
      Page Icons .................................................................. 15
      Overview Page Portlets .................................................. 16
      Tab Menus ................................................................... 16

Chapter 2: Getting Started ......................................................... 17
   Home Menu ...................................................................... 17
   Set a Home Page ............................................................. 18
   View Your Information ..................................................... 18
      Action Items .................................................................. 19
      Tasks ........................................................................... 22
      Processes ..................................................................... 24
      Notifications ................................................................ 26
   Favorites ........................................................................... 27
      Save a Page as a Favorite ............................................... 27
      Add a Favorites Page Link ............................................ 27
      Add a Favorites Action Link ......................................... 28
      Add a Favorites Menu Section ...................................... 28
      Reorder Menu Sections ................................................ 29
      Remove a Menu Section or Link ................................... 29

Chapter 3: Page and Portlet Basics ......................................... 31
   The Options Toolbar .......................................................... 31
   Filtering ............................................................................ 32
      Create a Filter .................................................................. 33
      Use a Filter Portlet .......................................................... 33
      Filter a List .................................................................... 33
      Filter a Hierarchical List ................................................. 34
      Build a Power Filter ........................................................ 34
      Delete a Saved Filter ...................................................... 36
   Sorting ............................................................................... 36
Chapter 4: Personal Dashboards 47

About Personal Dashboards ........................................................................................................... 47
View a Dashboard ........................................................................................................................... 48
Export a Dashboard ....................................................................................................................... 48
Export a Portlet .............................................................................................................................. 49

Chapter 5: Viewing and Posting Discussion Topics 51

About Discussions ......................................................................................................................... 51
Open a Discussions List Page ....................................................................................................... 52
Create a New Discussion Topic ................................................................................................. 52
Post a Message to a Discussion Topic ....................................................................................... 53
Post a Reply to a Message ......................................................................................................... 54
Expand or Collapse a Discussion Thread .................................................................................... 55

Chapter 6: Documents and Folders 57

Document Repository Overview ................................................................................................. 57
  Knowledge Store Access Rights .............................................................................................. 57
  Knowledge Store and Document Manager Permissions ....................................................... 58
  View the Knowledge Store ..................................................................................................... 59
  View the Document Manager ................................................................................................. 59
Folders ........................................................................................................................................ 60
  Create a Folder ........................................................................................................................ 60
  Add a Document to a Folder ................................................................................................... 61
  Download Files from Folders ................................................................................................. 63
Chapter 7: Global Search Tool

About the Global Search Tool ................................................................. 71
Perform a Basic Search ........................................................................ 71
Perform an Advanced Search ............................................................... 72
Global Search Techniques ................................................................... 73
  Use Wildcard Characters in a Global Search ...................................... 73
  Use Boolean Operators in a Global Search ........................................ 74
  Form Subqueries in a Global Search .................................................. 75

Chapter 8: Timesheets

Timesheet Overview ............................................................................. 77
How to Work with Timesheets ............................................................ 77
Access an Unsubmitted Timesheet ...................................................... 78
How to Add Tasks to a Timesheet ....................................................... 78
  Populate a Current Timesheet ......................................................... 78
  Add Entries to a Timesheet Manually .............................................. 79
Enter Work Hours into a Timesheet .................................................... 80
Specify Entry Input Type and Charge Codes ........................................ 81
Split Entry Input Type Codes and Charge Codes ............................... 81
Time Entry ETC .................................................................................. 82
Submit a Timesheet for Approval ........................................................ 82
Edit a Timesheet Before Approval ..................................................... 83
Timesheet Notes .................................................................................. 83
  Add a Note to a Task Entry ............................................................. 83
  Add a Note to a Timesheet ............................................................. 84
  Edit a Timesheet or Time Entry Note .............................................. 84
Email from Within a Timesheet ......................................................... 85
How to Correct a Returned Timesheet ............................................... 85
Print a Timesheet ................................................................................ 86
Chapter 9: Reports and Jobs

Reports Overview .................................................................................................................. 87
About Report Security ........................................................................................................... 87
Jobs Affecting Report Information ....................................................................................... 88
Run or Schedule a Report To Run ....................................................................................... 88
Scheduled Report Runs ......................................................................................................... 88
Define or Edit Scheduled Report Run Properties .............................................................. 89
View the Status of a Scheduled Report Run ........................................................................ 91
Delete a Scheduled Report Run ......................................................................................... 92
Add a Report to the My Reports Portlet .............................................................................. 92
View a Generated Report ................................................................................................... 93
Delete Generated Reports .................................................................................................. 93
Pause or Resume Scheduled Report Runs ........................................................................... 94
Cancel Scheduled Report Runs .......................................................................................... 94

Jobs Overview ..................................................................................................................... 95
Run or Schedule a Job to Run ............................................................................................. 95
Scheduled Job Runs ............................................................................................................. 96
Define or Edit Scheduled Job Run Properties ................................................................... 96
Pause or Resume a Scheduled Job Run .............................................................................. 98
View the Status of a Scheduled Job Run ............................................................................ 99
Cancel a Scheduled Job Run ............................................................................................... 100
View the Job Log .................................................................................................................. 100
Delete a Scheduled Job Run ............................................................................................... 101

Chapter 10: Account Settings ............................................................................................. 103

How to Manage Your Account .......................................................................................... 103
Manage Your Personal Information .................................................................................... 103
Update Your Password ....................................................................................................... 105
Designate Proxies ............................................................................................................... 106
View Your List of Proxies ................................................................................................... 106
Notifications Setup ............................................................................................................ 107
Notification Functional Areas ............................................................................................ 107
Manage Your Notification Settings .................................................................................... 108
Specify Notification Methods ............................................................................................ 108
Software Downloads .......................................................................................................... 109
Download Software ............................................................................................................ 110

Appendix A: Keyboard Shortcuts ....................................................................................... 111

Keyboard Shortcuts for Basic Features ............................................................................... 111
Keyboard Shortcuts for CA Clarity PPM Actions ................................................................. 111
Keyboard Shortcuts for Lists

**Appendix B: Crystal Reports Stock Report Descriptions**

<table>
<thead>
<tr>
<th>Report Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget Forecast Analysis Report</td>
<td>115</td>
</tr>
<tr>
<td>Chargeback GL Account Activity Report</td>
<td>119</td>
</tr>
<tr>
<td>Customer &amp; Provider Chargeback Report</td>
<td>121</td>
</tr>
<tr>
<td>Key Tasks and Milestone Status Report</td>
<td>124</td>
</tr>
<tr>
<td>Missing Time Report</td>
<td>127</td>
</tr>
<tr>
<td>Portfolio Alignment Report</td>
<td>129</td>
</tr>
<tr>
<td>Investment Status Report</td>
<td>133</td>
</tr>
<tr>
<td>Project Transactions Inquiry Report</td>
<td>138</td>
</tr>
<tr>
<td>Resource Assignments Report</td>
<td>144</td>
</tr>
<tr>
<td>Resource by Role Description Report</td>
<td>147</td>
</tr>
<tr>
<td>Timesheet Detail Report</td>
<td>149</td>
</tr>
</tbody>
</table>

**Appendix C: Access Rights**

<table>
<thead>
<tr>
<th>Access Rights Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Trail Access Rights</td>
<td>153</td>
</tr>
<tr>
<td>Basic User Group Access Rights</td>
<td>153</td>
</tr>
<tr>
<td>Dashboard Access Rights</td>
<td>154</td>
</tr>
<tr>
<td>Reports Access Rights</td>
<td>154</td>
</tr>
<tr>
<td>Software Download Access Rights</td>
<td>155</td>
</tr>
<tr>
<td>Timesheets Access Rights</td>
<td>155</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction

This section contains the following topics:

About this Guide (see page 11)
CA Clarity PPM Training and Training Tools (see page 11)
Quick Tour of CA Clarity PPM (see page 12)

About this Guide

This guide introduces basic information and techniques for working in CA Clarity PPM. This guide assumes that the reader is a non-administrative CA Clarity PPM user who has the appropriate access rights to needed perform basic functions.

The procedures described are for CA Clarity PPM with no customization. If you have personalized changes or if an administrator has modified the user interface, the procedures can vary from what you see.

CA Clarity PPM Training and Training Tools

For implementation teams, CA Technologies offers instructor-led and self-paced CA Clarity PPM training. This training is designed to help implementation teams understand CA Clarity PPM functionality so they can make informed decisions on configuring CA Clarity PPM.

For user training, CA Technologies offers the CA Productivity Accelerator (CA PA) solution. You can use this solution to create custom education materials and practice simulations and assessments. The custom education materials are used in classroom training and online simulations. Your users can access the practice simulations and assessments from the Learn link on the User toolbar, or from the learning management system (LMS). CA PA provides standard content modules that you can upload into your CA PA editor and modify to reflect your configuration of CA Clarity PPM. You can also integrate organizational processes and procedures into the CA PA solution.

CA Education offers these training solutions. To learn more about the training offerings and CA PA, see http://ca.com/education.
Quick Tour of CA Clarity PPM

The following illustration shows the default home page for CA Clarity PPM and its main components. The components and features available from this page are described in the following sections.
Main Menu

Move the cursor over the following features on the main menu to see a tooltip that identifies the feature.

<table>
<thead>
<tr>
<th></th>
<th>Home</th>
<th>Administration</th>
<th>Favorites</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Back</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Recent Pages (History)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Home, Administration, and Favorites Menus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Refresh</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Current Timesheet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Search</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following list explains the numbered features in the preceding figure:

1–Back

Returns you to the previous page. The page you return to is based on the previous entry in the Recent Pages list.

2–Recent Pages (History)

Provides a drop-down list of the pages most recently viewed. You can select from the list to return to a page. Entries are not made for navigation between subpages that belong to a specific instance. For example, if you are navigating between the subpages of a specific project, the subpages are not listed in the Recent Pages list.

3–Home, Administration, and Favorites Menus

Provide the navigation to all CA Clarity PPM pages. The menus and options that you can view depend on your access rights.

4–Refresh

Renews the data on a page.

5–Home

Returns you to the home page.

6–Current Timesheet

Takes you to your current open timesheet.

7–Search

Opens a search window for CA Clarity PPM.
Quick Tour of CA Clarity PPM

User Toolbar

The User toolbar always displays at the top of the CA Clarity PPM page.

Logout
Logs you out, ends the session, and presents the Login window.

Help
Provides online help information for individual CA Clarity PPM pages.

About
Provides information about the CA Clarity PPM version, the logged-in user, and third-party software.

Learn (Optional)
Presents the CA PA training modules for your organization. If CA PA is not set up for your organization, the link does not display.
Page Icons

The icons shown in the following figure provide quick access to functions needed on a CA Clarity PPM page. Not all icons appear on all pages. If the icons do not appear, the functions they represent are not available for the page.

Export to Excel

Exports information from a page to an Excel format. If a page does not have portlets, the icon does not appear.

Export to PowerPoint

Exports content from a page to a PowerPoint format. If a page does not have portlets, the icon does not appear.

Personalize

Lets you customize a page by adding or removing a portlet, adding or removing a filter, or changing the layout of portlets.

Manage My Tabs

Lets you create new tabs, add content to tabs, and change the layout of portlets on tabs.

For information about using the Personalize or Manage My Tabs icons, see the Personalizing CA Clarity PPM User Guide.
Overview Page Portlets

A portlet provides a snapshot of specific CA Clarity PPM data. A portlet can be a list, a chart, or a snippet of HTML. You can select the data that displays in a portlet.

The *Overview* page, contains the following portlets:

**Action Items**
Provides a list of action items assigned to you.

**Favorite Links**
Provides a list of internal CA Clarity PPM links you save.

**Favorite Photo**
Provides a list of your photos.

**My Projects**
Provides a list of projects you select for easy access from this portlet.

**Notifications**
Provides a list of notifications sent to you.

**Site Links**
Provides a list of external internet sites you save.

Tab Menus

Some tabbed pages have menus on the tabs. When you select a tab on a page, if a menu is available for the tab, an arrow displays on the tab.

Click the displayed tab once to open the menu and view the menu options.

The following illustration shows the open Team tab menu.
This section contains the following topics:

- Home Menu (see page 17)
- Set a Home Page (see page 18)
- View Your Information (see page 18)
- Favorites (see page 27)

### Home Menu

The Home menu is the main menu for CA Clarity PPM users. The following illustration shows the Home menu expanded. To open and expand the menu, move the pointer over the menu name.

The menu options that appear on the Home menu depend on the rights granted to you. Menu selections can vary for each user.

The menu includes the following features:

**Previous and Next**

Scrolls to the right or the left when clicked. If the Next button is active (bolded), more menus appear to the right on the menu. If the Previous button is active, more menus appear to the left.
Set a Home Page

**Set as Home**
Sets the page currently open as your home page.

**Reset Home**
Resets the home page to the default home page, the *Overview* page.

**Refresh**
Updates the menu to include recent changes.

**Set a Home Page**

The default home page is the *Overview* page. You can make any page the home page.

**Follow these steps:**
1. Navigate to the page you want as the new home page.
2. Open Home and click Set as Home at the bottom of the menu.

To reset the home page to the default Overview page, open Home and click Reset home at the bottom of the menu.

**View Your Information**

To view your CA Clarity PPM information, open one of the following pages:

**Overview**
To view this page, open the Home menu and from Personal, click Overview.

Overview is the default home page. This page contains portlets that list your action items and notifications. This page also contains portlets to which you can add:

- Personal links for easy access to projects
- Pages inside CA Clarity PPM
- External internet addresses
- Favorite photos

For information about how to configure portlets, see the *Personalizing CA Clarity PPM User Guide*.

**Organizer**
To view this page, open the Home menu and from Personal, click Organizer.

This page contains detailed information about your action items, tasks, processes, and notifications.
**Action Items**

Action items are nontasks that you assign to yourself, or others assign to you. You can use action items to track the progress of projects and to help ensure that a project is complete and on time.

You create personal action items from the organizer page and project-related action items from within a project. The Action Items tab on the organizer page lists all of the personal and project-specific action items that you create. The Action Items tab also lists action items that others create and assign to you.

**Create a Personal Action Item**

You can create both personal and project-related action items. This procedure describes how to create a personal action item.

See the *Project Management User Guide* for more information.

Follow these steps:

1. Open Home, and from Personal, click Organizer.
   
   The action items page appears.

2. Click New.
   
   The create page appears.

3. In the General section, complete the following fields:

   **Subject**
   
   Defines the name for this action item.

   **Description**
   
   Defines the description of the action item.

   **Priority**
   
   Specifies the priority level of the action item.

   **Values:** Low, Medium, or High

   **Due Date**
   
   Defines the date the action item is due for completion. If desired, select the hour and minute the action item is due.

   **Recurring**
   
   Indicates if the action item occurs at regular intervals. If the action item is to occur only once, clear this check box.
Frequency

Specifies how often the action item to reoccur.

Example: Enter 1 in this field to create a status report each week.

Units

Specifies the time period during which the action item reoccurs.

Values: Days, Weeks, Months, and Years

Until

Indicate the last date on which you want the action item to reoccur.

4. In the Notify section, complete the following fields, and save:

Notify Assignees

Indicates how a notification is sent:

■ Email message to the overview page
■ SMS message to the assigned resource

Send Reminder

Indicates if a reminder email notification is sent to the assigned resource (or resources) when the action item is due.

Time Before Reminder

Defines the amount of time before an item is due that the reminder occurs. For example, enter 15 in this field, and select Minutes in the Units field.

Units

If the Send Reminder check box is selected, this field specifies the unit of time for the reminder.

5. In the Assignees section, enter the name of the resource to assign the action item.

Edit an Action Item

You are the owner of action items you create. As the owner, you can modify or delete an action item.

You can modify the properties of a personal action item you create from the action item properties page. For an action item assigned to you by another user, you can update only the status.
Follow these steps:
1. Open Home, and from Personal, click Organizer. The action items list appears.
2. Complete the following field for the action item, and save:
   **Status**
   Specifies the action items status for each assignee.
   **Values:** Open, In Progress, Closed, Deferred, Done.

Follow these steps:
1. Open Home, and from Personal, click Organizer. The action items list appears.
2. Click the name of the action item to open it. The details page appears.
3. Click Edit.
4. Edit the action item fields, and save. The updates to the action item are complete.

Add and Remove Action Item Assignees

You can add or remove assignees from an action item.

Follow these steps:
1. Open Home, and from Personal, click Organizer. The action items list appears.
2. Click the name of the action item to open it. The details page appears.
3. Click Edit. The properties page appears.
4. Complete the following field, and save:
   **Assign To**
   Defines the name of the resource assigned to the action item.
   **Default:** The resource currently logged in.
View an Action Item and Item Details

You can view and act on your action items.

Follow these steps:
1. Open Home, and from Personal, click Organizer.
   The action items list appears.
2. Click the name of the action item to open it.
   The details page appears.
3. Click the subject of an action item to view the details.

Tasks

You can view personal tasks that you create in Project Management and those others assign to you. A task entry appears in the task list for each assigned task. You can use this page to take the following actions:
- Edit the displayed task properties
- Open the task
- Mark a task as complete or not complete

See the Project Management User Guide for more information.

To edit a personal or assigned task:
1. Open Home, and from Personal, click Organizer.
   The action items list appears.
2. Click Tasks.
   The tasks list appears.

The following columns appear on the task list. You can edit the appropriate cells as needed:

Task

Defines the name of the task. The value for the field is derived from the Name field on the task properties page. On list pages or in portlets, displays the name of the task. You can click the task name to open the task properties page.

Limits: 64 characters
Required: Yes
Investment
Displays the name for the investment. The value for this field is based on the Project Name field on the project properties page. Click this link to open the investment.

Start
Defines the date of starting the task assignment for a resource. The list pages or portlets display the start date.

Default: Task start date
Required: Yes
Note: Define the assignment to start on or after the task start date. If an assignment has actuals, the field is view only.

Finish
Defines the date of completing the task assignment for a resource. The list pages or portlets display the completion date.

Default: Task completion date
Required: Yes
Note: Define the assignment to finish on or before the task completion date.

Actuals
Defines the total work units that a resource has worked and posted to the task assignment.

Pending Actuals
Displays the number of hours entered by a resource on a submitted timesheet that is waiting to be posted.

ETC
Displays the estimated hours to complete the task. You can click in the cell to edit.

Assignment Status
Displays the status of the task. The value for this field is from the Status field on the task properties page.

Values:
- Not Started. No time is posted against the task.
- Started. Automatically changes the status to "Started" when time was posted against the task.
- Completed. Automatically changes the status to "Completed" when the task ETC has zero hours and the task status is updated to "Completed".
3. Click Save.
   Your updates are saved.

Processes

A process is a series of actions (steps) in CA Clarity PPM resulting in an end. All processes have the following characteristics:

- A start step and finish step.
- Post-conditions and preconditions to connect the steps.

Each step performs a single action that is intended to move the process toward its completion.

**Note:** Processes are not explicitly marked as complete. The completeness of a process instance depends on the status of the steps it contains. When the Finish step is completed, the process instance ends.

You can view the following processes from the Organizer:

- Initiated. Process instances that you started or to which you have view access.
- Available. Processes available for you to initiate and to edit their definitions.

**View an Initiated or Available Process**

You can filter and view a list of initiated or available processes. From a list, you can do the following:

- For initiated processes, you can view the status or click a process link to view the step details.
- For available processes, you can start a process or click a process link to edit its definition. You can also create new processes.

**Note:** To view a list of all available global processes, process administrator access is required.

**Follow these steps:**

1. Open Home, and from Personal, click Organizer.
   The action items list appears.
2. Click Processes.
3. Open the Processes menu, and click Available or Initiated.
   A list page with initiated or available processes appears.
Start a Process

Each time a process is started, by either a manual action or an automated trigger, a process instance is created.

**Follow these steps:**

1. Open Home, and from Personal, click Organizer.
   
   The action items list appears.

2. Click Processes.

3. Open the Processes menu and click Available.
   
   The list of available processes appears.

4. Select the check box next to the process you want to start, and click Start.
   
   The initiated processes page appears displaying the new process instance.

Modify a Process

You can only modify processes that have a mode set to Draft or On Hold. If the mode is set to Active, you cannot modify a process. The appropriate access rights are required to modify a process.

**Follow these steps:**

1. Open Home, and from Personal, click Organizer.
   
   The action items list appears.

2. Click Processes.

3. Open the Processes menu, and click Available.
   
   The list page appears.

4. Click the name of the process to modify.
   
   The properties page appears.

5. Do the following:
   a. Modify the generic attributes for this process.
   b. Update the process steps as desired by adding, renaming, deleting, adding conditions to, or altering actions.
   c. Update groups by adding, removing, reorganizing, or renaming them.
   d. Update escalation properties by changing escalation type, level, grace period, or additional notifications.
   e. Click the Validation link to validate the process modifications. If errors are identified, correct them and revalidate the process. If no errors are identified, click Exit.
Cancel a Process Instance

You can cancel only active and incomplete processes. When you cancel a process instance, the process instance stops at the step in progress.

Canceled process instances are not deleted and remain for reference purposes. You cannot reinstate a canceled process.

Follow these steps:
1. Open Home, and from Personal, click Organizer.
   The action items list appears.
2. Click Processes.
3. Open the Processes menu and click Initiated.
   The list page appears.
4. Select the process instance, and click Cancel Process.
   The confirmation page appears.
5. Click Yes.

Notifications

A notification can be an alert, an email, or an SMS message that notifies you of new activities or changes in CA Clarity PPM. The alerts that you can see are for your assigned action items or overdue timesheets.

Alert notifications appear in the following locations:
- Overview page on the Notifications portlet
- Organizer page on the Notifications tab

Open an Action Item from Notifications

The following procedure explains how to open an action item from the notification list. You can delete notifications that you no longer need.

Follow these steps:
1. Open Home, and from Personal, click Organizer.
   The action items page appears.
2. Click Notifications.
   The notifications list appears,
3. Click the link in Message column or the Properties icon that displays next to the alert notification.
Favorites

The Favorites menu lets you store a link to any page as a favorite for easy access at any time. Favorites is a personal menu that you can use to store the links you use every day.

Save a Page as a Favorite

You can save any page as a favorite.

Follow these steps:
1. Open the page to save as a favorite.
2. Open the Favorites menu, and click Add Current.

Add a Favorites Page Link

Follow these steps:
1. Open Favorites, and click Configure.
2. Click Add.
   The create page appears.
3. Select Page Link and click Next.
   The menu item properties page appears.
4. Complete the following fields, and save:
   - **Link Name**
     Defines the label for the page link that appears in the menu.
   - **Description**
     Defines the purpose for the section or page link.
   - **Page Name**
     Specifies the page that appears when the link is clicked.
   - **Parent Menu Item**
     Specifies the menu section in which the link appears.
Add a Favorites Action Link

Use this procedure to add an object action that performs a task to the Favorites menu.

Follow these steps:
1. Open Favorites, and click Configure.
2. Click Add. The create page appears.
3. Select Action Link and click Next. The menu item properties page appears.
4. Complete the following fields:
   - **Link Name**
     Defines the name of the link that performs an action. This is the label for the link that displays in the menu.
   - **Description**
     Defines the purpose of the link.
   - **Action Name**
     Specifies the action that occurs when the link is clicked in the menu.
   - **Parent Menu Item**
     Specifies the section in which the link appears.
5. Click Save and Return.

Add a Favorites Menu Section

Follow these steps:
1. Open Favorites, and click Configure.
2. Click Add. The create page appears.
3. Select Section and click Next. The menu item properties page appears.
4. Complete the following fields:
   - **Section Name**
     Defines the name for the section.
Section ID
Defines the unique identifier for the section.

Description
Defines the purpose for the section or page link.

5. Click Save and Return.

Reorder Menu Sections

Use this procedure to reorder sections and links in the Favorites menu.

Follow these steps:
1. Open Favorites, and click Configure.
2. Click Reorder.
   The reorder menu page appears.
3. In the Menu Items list box, select a section and click the up or down arrows to move the section to a new position.
4. Save the changes.

Note: If you don’t see your changes reflected in the menu, click the Refresh button.

Remove a Menu Section or Link

Use this procedure to remove a menu section, page link, or action link. You can only remove sections or links that you have created. You cannot remove CA Clarity PPM default sections or links.

Follow these steps:
1. Open Favorites, and click Configure.
2. Select the check box next to the section or link to delete, and click Remove.
   The confirm menu item delete page appears.
3. Click Yes.
Chapter 3: Page and Portlet Basics

This section contains the following topics:

- The Options Toolbar (see page 31)
- Filtering (see page 32)
- Sorting (see page 36)
- Exporting a List (see page 38)
- Edit Information Directly in a List (see page 41)
- Insert an Item in a List (see page 41)
- Select All Items in a List (see page 42)
- Gantt Columns in Lists (see page 42)
- Auto Suggest (see page 42)
- Present a Page as a Pop-up (see page 43)
- Maximize or Minimize a Portlet (see page 44)
- Charts (see page 44)

The Options Toolbar

The Options toolbar displays at the top of lists. The toolbar options help you manage the information included in the list. The following illustration shows:

- Filter option
- Options menu (expanded)

The toolbar options let you do the following:
Filtering

Filter

Lets you filter the list with criteria you select. You can expand or collapse the filter by double-clicking the toolbar or by clicking the icons (+ or -) that appear beside the filter name. The filter in use is listed in the filter field. Click the down arrow to see a list of saved filters.

Options Menu

This menu contains options that apply to the portlet being viewed. The options that appear can vary depending on the portlet. The following list shows some of the menu options that can appear on the Options menu.

Configure

Lets you do the following:

- Modify the list and filter fields
- Modify the list and filter layout
- Aggregate the information in columns
- Set options for how the list displays
- Define the display settings for a Gantt chart
- Define the time period settings for a time-scaled value

Note: For information about settings for Gantt charts and time-scaled values, see the Personalizing CA Clarity User Guide.

Multisort

Lets you sort the information in a list using multiple columns.

Export to Excel (Data Only)

Exports the information in the list to a Microsoft Excel format. No charts are included this export.

Filtering

List pages consist of two sections: a filter and the list. At the top of the page, the filter section contains search fields that you can specify search criteria. On most pages, this section is collapsed.

Below the filter section is the list. For example, on the projects list page, the list displays projects based on the filtering criteria you entered. If you do not enter filtering criteria, all items display in the list.
Create a Filter

You can enter criteria and filter once, or you can name the filter and save the criteria for later reuse. You can access saved filters from the Filter drop-down.

Follow these steps:

1. Open the list page.
2. Click the Expand Filter icon at the top of the list if the filter is not open.
3. Enter filtering criteria in the filter section of the page, and click Save Filter.
   The save filter page appears.
4. Enter a name for the filter.
5. To make this filter the default filter for this list page, select Default.
6. Click Save and Return.

Use a Filter Portlet

Some pages have filter portlets that coordinate filtering across portlets on a single page or across multiple pages. Filter portlets appear on list pages in a Filter section, and on some pages, in a toolbar. To filter a list, enter values in the filter portlet fields and click Filter. The portlets configured to work with the filter portlet are filtered using the values you enter in the filter portlet fields.

To filter an individual portlet on a page, enter selection criteria in the Filter section for that portlet and click Filter.

Filter a List

Lists with many items can span multiple pages. Use the filter fields to filter the list to only those items you want to view. To see all the results, click each pagination link at the bottom of the list page.

Use the Expand/Collapse Filter icon on the Options toolbar to hide or display the filter. Filter fields are not case-sensitive. For example, Acme, acme, and ACME return the same results. When a list is filtered, you can return to the default results list and view all the items in the list page. Click Show All or select System Default from the Filter drop-down.
**Follow these steps:**

1. From a list page, click the Expand Filter icon on the Options toolbar. The filter section of the page displays.
2. Enter filtering criteria into the fields in the filter section of the page, and click Filter. All items that match the filtering criteria appear in the list.

**Filter a Hierarchical List**

When you apply a filter to a hierarchical list, the expanded items collapse. The resulting filtered items include its parent and up the hierarchy to the top-level item, and all rows display collapsed.

**Build a Power Filter**

A power filter is a custom filter that searches a list page by criteria you define. Use a power filter alone or with other filter fields on the list page. Only one power filter can be created for a list page.

You design and build a power filter using an expression, usually in two parts (left and right) and separated by an operator (such as, =). For example, the expression to search for all active projects on the projects list page appears in the Expression text box as the following: `project.is_active == 1`.

**Follow these steps:**

1. With a list page open, expand the filter.
2. Click the Build Power Filter link in the filter section. The power filter page appears.
3. Build the left part of the expression by completing the following fields:
   
   **Note:** The available fields are dependent on the page displayed.

   **Object**
   
   Specifies the type of object to filter. The page refreshes.

   **Field**
   
   Specifies the field to display in the Filter section. The page refreshes.
4. Select one of the following operators:
   
   **Note:** The operators that are available are dependent on the object and field values used for the left part of the expression.
   
   - =
   - !=
   - >
   - >=
   - <
   - <=

5. Complete the following fields to build the right part of the expression:
   
   **Note:** The fields that are available are dependent on the page displayed.

   **Constant**
   
   Specifies the constant for the field.
   
   **Values:** Yes or No
   
   **Example:** Select the Active field of the project object and use the equals operator, then select Yes as the constant. This combination finds all active projects.

   **Object**
   
   Specifies the type of object to filter. The page refreshes.

   **Field**
   
   Specifies the field to display in the Filter section. The page refreshes.

6. Click Add.

   The expression appears in the Expression field.

7. Select a value from the following field if you want to create an equation with multiple clauses. For example, you can create a power filter with multiple clauses to display all active projects that are also assigned to a specific department. If you select a value from this field, create the additional clause for the expression and click Add. This action appends the clause to the value in the Expression field.

   **And/Or**
   
   Specifies the equation type for the second half of the expression.
   
   **Values:**
   
   - And. Defines an equation with multiple clauses.
   - Or. Defines an either/or equation.
8. Do one of the following:
   ■ Click Evaluate to evaluate the syntax of the expression. If the syntax is not valid, INVALID appears above the expression text box.
   ■ Click Add Parenthesis to surround the expression with parentheses.
   ■ Click Negate Expression to negate the expression by surrounding the expression with parentheses and preceding it with an exclamation point.
   ■ Click Clear to clear the expression text box.

9. Save the changes.
   The power filter is saved. The name appears in the Power Filter field of the page filter.

Delete a Saved Filter

You can delete saved filters using the manage filters page. You can also delete saved power filters.

Follow these steps:
1. With a list page open, select Manage Filters from the Filter drop-down.
   The manage filters page appears.
2. Select the check box next to the name of each filter you want to delete, and click Delete.
   The list page appears and the filter no longer displays in the Filter drop-down.

Follow these steps:
1. With a list page open, expand the filter.
2. Click the name of the filter next to Power Filter.
   The power filter page appears.
3. Click Delete.

Sorting

Perform a Simple List Sort

Information is listed in alphabetical or numeric order according to the information in the field. You can sort lists by row or column. Once the list is sorted, you can reset the sort to the default sort order.
Sort Hierarchical List by Row

You can sort parent items in lists. When the list is sorted, the child items inherit the sorting criteria of the parent. For example, if you sort the list in ascending order, the parent and its child items sort in ascending order.

Sort List by Column

To sort a column, click the column header. For example, to sort the work breakdown structure by task name, click the Task Name column header. When the list is sorted, an arrow appears in the column header. To reverse the sort order, click the column header again. Do the same to sort by any other column headers.

Sort a List by Multiple Columns

Change the order of information on a page by:

- Changing the sort order of columns
- Sorting by multiple columns

Use the Multisort option to change your page layout.

Follow these steps:
1. Open a list page.
2. Open the Options menu by clicking the icon on the Options toolbar, and select Multisort.
   The sort by multiple columns page appears.
3. Complete the following fields, and save:
   First Field
   Specifies the column that leads the sort order.
   Type:
   - Text. Information displays in the alphabetical order.
   - Numbers. Information displays in the numerical order.
   Second Field
   Specifies the column that defines the second order of the sort.
   Example: Select “User Name” in the first field and “ID” in the second. The list is sorted by user name and then by ID name or number.
   Third Field
   Specifies the column that defines the third order of the sort.
Fourth Field
Specifies the column that defines the fourth order of the sort.

4. For each selection you make in a Column field, indicate the direction of the sort for that column (ascending or descending).

Exporting a List
You can export the information from any list portlet that displays the Export to Excel (Data Only) icon on the Options toolbar. If the icon is not displayed, the list is restricted.

Export Rules
The following rules apply when you export information in a list:

■ If you apply filter criteria, only the filter results are exported.
■ Only the first level items are exported.
■ Only the fields displayed in the list are exported.
■ Only the items listed on the page are exported. If more than one page of items exist, export these pages independently.
■ For items that contain charts (including Gantt charts), you can export a maximum of 300 items.
■ To export an unlimited number of items without charts, use the Export to Excel (Data Only) option.
■ The exported information appears in Excel or PowerPoint the way that the information appears in CA Clarity PPM.
■ You can export some CA Clarity PPM pages that contain portlets, like the overview page. If you can export a page of portlets, the File menu has the export options available.
Export Information to Microsoft Excel

To use statistical operations such as SUM and AVERAGE fully, export and view a list in a Microsoft Excel spreadsheet format. Exporting to an Excel spreadsheet is especially helpful when the list extends over multiple pages.

Before you export information, verify that you are exporting the returned results and have not applied any pagination.

Follow these steps:
1. With a list page open containing the information for exporting, click the Export to Excel icon.
   The file download page appears.
2. Open the list as an Excel spreadsheet, or save it to your local desktop.

How Information Transfers from CA Clarity PPM to Excel

When you export CA Clarity PPM information to Microsoft Excel, the format settings for each column are exported to Microsoft Excel. Any formulas used for aggregating or comparing column values are exported. You can expect certain changes in how information is displayed in Excel.

The following list describes how the various values appear in the Excel spreadsheet:

- **String**: String
- **URL**: Hyperlinked string
- **Grid columns with links**: If the link is an image, then the column information in Excel is the image description (alternate text).
- **Boolean image or value**: Yes/No
- **Number or formula or virtual icon column (such as image, stoplight, value, or range description)**: Up to three columns: one for value (number), one for range description, and one narrow column with background color if stoplights are displayed. Formulas export actual values, not the formulas themselves.
- **Date**: Date formatting is preserved.
Money
Two columns: numeric value and currency code. Correct number of decimal places is preserved.

Virtual Gantt primary bar data
Three columns: Item name, start date, and end date, in addition to a Gantt chart column header prefix to show they all belong together.

Virtual Gantt secondary bar data
Three columns: Item name, start date, and end date, in addition to a Gantt column header prefix to show the columns belong together. The header prefix shows also shows the columns are different from the primary bar.

Virtual progress bar
Three columns: Current stage name, current stage number, and number of stages, in addition to a Progress column header prefix to show the columns belong together.

Column header
If present in CA Clarity PPM, this value appears.

Secondary value
Appears in a separate column; the column header title uses the attribute name.

Time-scaled values
One column for each time slice (years, months, quarters, weeks, or days). In addition, a Gantt column header prefix shows the time slices belong together.

Aggregation, comparison, and variance rows
The values or results are displayed in rows. The values are gray and do not display a corresponding row header. Select an aggregation or comparison value to see the formula used for calculating the value in the Excel formula bar.

Highlighted row by attribute
The two highlighted rows in Excel do not appear highlighted in Excel.
Edit Information Directly in a List

When you click in a field to update, the entire list is placed into edit mode. You can click links and icons in other fields while the list is in edit mode. Press the Esc key on your keyboard to return to display mode and discard unsaved changes.

Follow these steps:
1. Open the page containing the list.
2. Click in the field containing the information to edit.
   - If the field can be edited, the field changes to edit mode. If no action occurs, the field cannot be edited.
3. Make the update.
   - A flag appears in the field to indicate an unsaved update.
4. Save the changes.

Insert an Item in a List

When you insert an item, you can edit the fields for the item in the list. The fields displayed are required. The fields cannot be saved until you edit them. Once you save the changes, the default fields display and the auto numbered fields update. If the list includes a time-scaled value column and you want to edit the time-scaled information, save your changes first.

Note: If you filter the list, the inserted row must match the filter criteria for it to display in the results list.

Follow these steps:
1. Open a list page.
2. Select the check box or click anywhere on the item row to insert a new row below it.
3. Do one of the following:
   - Use the keyboard shortcut key:
     - Windows: Press Insert.
     - Macintosh: Press Ctrl+I.
   - Click New.
   The new row is inserted.
Select All Items in a List

You can select all items in a list on a single page before performing an action, such as adding or deleting. Use the Select All icon on the list page to select all items. For example, if you want to add all items in the list displayed on a page, click the Select All icon and then click Add.

**Note:** Lists can be long and span multiple pages. Repeat this process on each page for which you want to select all items.

Gantt Columns in Lists

The Gantt column always occupies the last position in lists. The Gantt is separated from all the other columns on the page by a split bar. The split bar is a vertical column divider that you can move from left to right.

Use the split bar to view more or less of the Gantt. Moving the split bar does not resize the other columns. Use the horizontal scroll bar at the bottom of the list to view a specific column in the list.

You can change the Gantt timescale to zoom in and out of the timeline. For example, to zoom in to daily timeline information, select the Days timescale value from the Calendar drop-down on the Gantt chart.

Auto Suggest

Auto suggest displays a list of values that match the characters you enter in lookup text fields.

For example, if you enter Bo in a lookup text field, the values starting with Bo display in the suggestion list. A counter displays below the search results to indicate the number of matching values. For example, the counter appears as **Displaying 10 of 36 results.** As you enter subsequent letters, the suggestion list narrows your choices and the counter reduces the number of matching results. Continue to enter subsequent letters until you find the desired value.

To see all available choices in a suggestion list, enter an asterisk (*) in the field.

Auto Suggest in Organizational Breakdown Structures (OBS) Fields

Auto suggest displays the results that match a value in the OBS. The results display is optimized to show the destination value in the suggestion list first and then other matching results. The destination value is the value that appears at the end of the OBS unit.
OBS Auto Suggest Example

Enter S to search for the Sales department OBS. The following results appear in the results list as you enter text because the values begin with the letter 's'. Notice that the OBS destination values appear first in the list.

- Department:ConsumerGoods/Sales
- Department:ConsumerGoods/Software
- Department:Shipping/International

The results that display depend on the OBSs created for your organization.

Search Multi-valued Lookup Field

A multi-valued lookup field allows you to select one or more values. After you enter the initial search letters, you can select the desired value for the field. You can continue to search for and add additional values to the field as needed. Click the X next to the value to remove the value from the selection list.

Multi-valued Lookup Auto Suggest Example

Enter Bo to search for users with names that start with 'bo'. Select Bob Smith. Bob Smith is added to field.

Present a Page as a Pop-up

Some lists display a Configuration icon in the Options toolbar. For these lists, you can set items selected from the list to display in a separate pop-up that floats above the workspace. A pop-up is one way to provide a visual reminder of where you are in the application. The popup has the same functionality as a page presented in the workspace.

Note: When you set an item on a list page to appear in a pop-up, all list items are set to appear in a pop-up.

Follow these steps:

1. Open the list page you want to configure.
   For example, to open the Projects list page, open the Home menu, and from Portfolio Management, click Projects.

2. Open the Options menu by clicking the icon on the toolbar, and click Configure.

3. Open the List Column Section menu, and click Fields.
4. In the Attribute column, locate the Name attribute, and click the Properties icon.

5. Select the Open as Pop-up check box, and click Save and Return.

6. Click Return.

   The pop-up setting is complete. Any item you click in the list appears in a separate pop-up window.

Maximize or Minimize a Portlet

You can maximize and minimize the portlets that display on pages. Portlets display on pages in the following ways:

**Maximized**

Displays a portlet at maximum page size. Any other portlets on the page are hidden from view.

To view other portlets while you have a portlet maximized, use the drop-down list on the Options menu that contains the portlet name. Any portlet you select also displays maximized.

To restore all portlets, open the Options menu and click Restore.

**Minimized**

Displays only the portlet toolbar. The information listed for the portlet is hidden. Open the Options menu for the portlet and click Restore to redisplay the portlet information.

Charts

You can use the three-dimensional and animation charting capabilities to organize and visually represent complex information. With charts, you can do the following:

- Mouse over data points to view additional information about dimension values and metrics.
- Drill down to view details on a data point on the chart.
- Slice a pie or funnel chart to call out information.
- Assign colors and change X and Y-axis labels.

You can display charts from any portlet page, such as the overview page or dashboards. You can add charts by personalizing pages or your CA Clarity PPM administrator can add charts using Studio.

See the *Personalizing CA Clarity PPM User Guide* for more information.

See the *Studio Developer’s Guide* for more information.
Set Chart Options

You can print, slice, or rotate charts by setting chart options.

Right-click a chart to set the following chart options:

- Print. Prints the chart.
- Slicing. Extracts slices from a pie or funnel chart. Slicing is the default setting.
- View 2-D. Temporarily changes to a two-dimensional view of the chart. When you leave the chart portlet page and return, the chart view is three-dimensional.

The following table describes the available options for each chart.

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>View 2-D</th>
<th>Slicing</th>
<th>Rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Bar</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Bubble</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Column</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Funnel</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Line</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Pie</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Scatter</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Chapter 4: Personal Dashboards

This section contains the following topics:

About Personal Dashboards (see page 47)
View a Dashboard (see page 48)
Export a Dashboard (see page 48)
Export a Portlet (see page 49)

About Personal Dashboards

You can create personal dashboards that display the specific information you want to see. You can create custom portlets to use in a personal dashboard, or if you have the appropriate access rights, you can use stock portlets.

See the Personalizing CA Clarity PPM User Guide for more information.

You can also view dashboards that other users have shared with you.

You can export the contents of a dashboard or an individual portlet displayed in the dashboard to Microsoft Excel or PowerPoint. The maximum size for Export to Excel or Export to PowerPoint is 300 records. If you use the Export to Excel (Data Only) option, there is no limit to the number of records that can be exported.

Note: You cannot export interactive portlets. These portlets are HTML portlets and cannot be exported.

You can fit the exported information to a page. This option is helpful if you are exporting information to PowerPoint for a presentation. You can also elect to place each exported portlet on a separate page. This approach avoids having all portlets fitted onto a single page as they might appear in a dashboard.
View a Dashboard

Follow these steps:

1. Open Home, and from Personal, click Dashboards.
   The dashboard list page appears showing dashboards created by you or shared with you by other users.
2. Do one of the following to view a dashboard:
   ■ Click the icon next to a dashboard in the list.
   ■ Click the name of a dashboard to open the details page, and from the Actions menu, click View Dashboard.

Export a Dashboard

A dashboard can be exported from the details page, or from a dashboard displayed for viewing.

If you are exporting a chart portlet, the chart displays in native Microsoft Office chart format.

Follow these steps:

1. Open Home, and from Personal, click Dashboards.
   The list page appears.
2. Click the name of the dashboard you want to export.
   The details page appears.
3. In the Export field, select the appropriate check boxes to indicate how you want the portlets to appear in Excel or PowerPoint.
   ■ To fit all exported portlets on a single sheet or page, verify that both check boxes are clear. If you are exporting to PowerPoint, some portlets can be truncated if the number of portlets is larger than the PowerPoint page can accommodate.
   ■ To export each portlet to a separate page with the current dashboard size, select One Page per Slide/Sheet.
   ■ To export each portlet to a separate page and fit the portlet to the page, select both One Page per Slide/Sheet and Fit to Page.
4. Open the Actions menu and click Export to Excel or Export to PowerPoint.
   The File Download dialog appears.
5. Click Open to display the file without saving, or click Save to save the file.
Export a Portlet

Display the dashboard for viewing to export an individual portlet. Some stock portlets are restricted and cannot be exported. If a portlet is restricted, the Export to icon for exporting does not appear in the Options toolbar.

Follow these steps:

1. Display the dashboard to view the individual portlets.

2. On the portlet you want to export, open the Options menu on the portlet toolbar and select one of the following options:
   - Export to Excel. This option exports the portlet information to Excel, including any portlet charts.
   - Export to Excel (Data Only). This option exports the portlet information to Excel but does not include charts.
   - Export to PowerPoint. This option exports portlet information to PowerPoint, including any portlet charts.

   The File Download dialog appears.

3. Click Open to display the file without saving, or click Save to save the file.
Chapter 5: Viewing and Posting Discussion Topics

Users with the appropriate access rights can access Discussions from within certain objects. Discussion allows its users to post discussion topics and reply to topics and messages.

This section contains the following topics:
- About Discussions (see page 51)
- Open a Discussions List Page (see page 52)
- Create a New Discussion Topic (see page 52)
- Post a Message to a Discussion Topic (see page 53)
- Post a Reply to a Message (see page 54)
- Expand or Collapse a Discussion Thread (see page 55)

About Discussions

Use the Discussion feature to exchange ideas and communicate in a common location on subjects relevant to the participating resources. This feature is available from the following locations:

- Projects and Programs
- Requisitions

See the Resource Management User Guide for more information.

Requires specific access rights to use discussions from the locations.

See the Project Management User Guide for more information.

Discussion Terminology

The following provides definitions of the standard message board terms you see when using discussions:

**Topic**

A topic is the top-level grouping for a message. Topics consist of a topic name (subject) and participants. Each topic can contain any number of threads.
Thread
A thread consists of a message and all of the responses to it.

Message
A message is the conversation part of a thread.

Reply
A reply is a response to a message, or to another response.

Open a Discussions List Page

You can open the list of discussion topics for a program or a project. Access to the discussion list for a project or program is required to open and view it.

Follow these steps:
1. Do one of the following:
   - Open Home, and from Portfolio Management, click Programs.
   - Open Home, and from Portfolio Management, click Projects.
   The list page appears.
2. Click the name of the program or project.
   The properties page appears.
3. Click Collaboration.
4. Open the Collaboration menu and click Discussions.
5. The list of discussion topics appears.

Create a New Discussion Topic

Only users who are collaboration managers can create new discussion topics. By default, the user who creates projects or programs is the collaboration manager. Additional collaboration managers can be designated.

An author cannot change topic or message content once it is posted. Only resources who are collaboration managers for the specified investment can delete discussion topics and messages.

See the Project Management User Guide for more information.
Follow these steps:

1. Open the discussions list page for the project or program.
2. Click New.
   The properties page appears.
3. Complete the following fields, and save:

   **Topic Name**
   Defines the name of the topic.

   **Access**
   Specifies the access applied to this discussion. To grant discussion access to all of the project or program participants, click All Resources/Groups.
   **Default:** All Resources/Groups

   **Selected Resources/Groups**
   Specifies the individuals who can participate in the discussion.

---

**Post a Message to a Discussion Topic**

Follow these steps:

1. Open the discussions list page for the project or program.
2. Click the name of the topic to which you want to respond.
   The messages page appears.
3. Click New.
   The properties page appears.
4. Complete the following fields:

   **Subject**
   Defines the subject of the message.

   **Message Text**
   Defines the text of the message.
Post a Reply to a Message

Follow these steps:
1. Open the discussions list page for the project or program.
2. Click the name of the message to reply.
   The replies page appears.
3. Click New.
   The properties page appears.
4. Complete the following fields:
   **Subject**
   Defines the subject of the message.
   **Message Text**
   Defines the text of the message.
   **Attach a Document**
   Defines the path of the document to attach to the message.

Post a Reply to a Message

**Access**
Defines the resources having access to the message.

**Values:**
- All Resources/Groups. Select this option to add all of the project participants.
- Selected Resources/Groups. Select this option to locate and add specific individuals to the discussion.

**Default:** All Resources/Groups

**Attach a Document**
Defines the path of the document to attach to the message.

**Notify Participants**
Specifies if you want the discussion recipients to receive an email notification when a new message arrives for their review.

**Default:** Selected

5. Save the changes.
   The message displays in the list messages page beneath the topic name.
Notify Participants

Specifies if you want the discussion recipients to receive an email notification when a new message arrives for their review.

Default: Selected

5. Save the changes.

The message you created displays in the replies list. Click the name of the subject to open and read it.

6. To return to the original message or to return to the list of topics, click the appropriate link at the top of the list.

Expand or Collapse a Discussion Thread

You can expand a thread to view all of the replies to a message and collapse it back to the message level.

Expanding a thread

When you expand a thread, you can see the expanded view of the message you selected. To expand a thread, select the message or reply whose contents you want to view, and click Expand.

Collapsing a thread

When you collapse a thread, the message or reply displays only its subject line. To collapse a thread, select the message or reply whose contents you want to collapse, and click Collapse.
Chapter 6: Documents and Folders

You can access and manage your documents from two repositories:

- The Knowledge Store
- Document Manager

This section contains the following topics:

- Document Repository Overview (see page 57)
- Folders (see page 60)
- Documents (see page 65)

Document Repository Overview

Your administrator maintains the Knowledge Store and Document Manager. These repositories contain documents on policies or procedures that pertain many people.

You can use the Knowledge Store for saving and accessing your generic documents. You can use Document Manager to do the following:

- To build a repository for project-related forms and documents
- To build a repository for program-related forms and documents
- To attach documents, such as a resume or an application form, to a resource profile

Though most users can access these repositories, their access to the folders and documents within it vary. With the appropriate permissions, users can create new folders, add documents to them, and edit both documents and folders. Key differences exist in the access rights of the two repositories.

Knowledge Store Access Rights

Access to the Knowledge Store and to its folders and documents are provided at the following levels:

- Access rights at the Knowledge Store level
- Permissions at the folder and document levels

The following rights to access are required to manage or view content in the Knowledge Store:
Knowledge Store - Administrate

Allows you to access all of the folders and documents in the Knowledge Store. Only users with the Knowledge Store - Administrate access right can create folders at the top level of the Knowledge Store folder tree. Users with the Knowledge Store - Access right and with the appropriate permissions can add sub folders and documents to the folders.

Knowledge Store - Access

Allows you to create, edit, and view documents and folders in the Knowledge Store to which you have access. Allows you to delete the folders you created, and the documents you added.

Knowledge Store - View All

Allows you to view all documents in the Knowledge Store.

Knowledge Store and Document Manager Permissions

The CA Clarity PPM administrator grants Knowledge Store access rights. Access to folders and documents are granted on a case-by-case basis. When you create or administer a folder or document, identify the users who need access to the folder or document. Then, give the users permission to read, read/write, or read/write/delete on the folder or document. The permission level determines the actions users can take on a folder or document.

The following table describes the permissions required for the Knowledge Store or Document Manager.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>You can do the following:</td>
</tr>
<tr>
<td></td>
<td>■ Open current and prior versions of a document</td>
</tr>
<tr>
<td></td>
<td>■ Check out current and prior versions of a document</td>
</tr>
<tr>
<td>Read/Write</td>
<td>You can do the following:</td>
</tr>
<tr>
<td></td>
<td>■ Open, read, copy, and move documents</td>
</tr>
<tr>
<td></td>
<td>■ Check in or check out documents</td>
</tr>
<tr>
<td></td>
<td>■ View checkin/checkout history</td>
</tr>
<tr>
<td></td>
<td>■ View document versions</td>
</tr>
<tr>
<td></td>
<td>■ View and modify document properties</td>
</tr>
<tr>
<td></td>
<td>■ View and modify document permissions</td>
</tr>
<tr>
<td></td>
<td>■ Attach processes for documents</td>
</tr>
<tr>
<td></td>
<td>■ Add new folders and documents</td>
</tr>
<tr>
<td>Permission</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Read/Write/Delete</td>
<td>You have all the read/write permissions, plus you can move and delete documents and folders.</td>
</tr>
</tbody>
</table>

All Document Manager participants are automatically given the read permission. The project manager, the program manager, the resource manager, or CA Clarity PPM administrator grants the other permissions.

**View the Knowledge Store**

You can view folders to which you have access using the Knowledge Store page.

**Note:** If you do not see the Knowledge Store link, you do not have access to the Knowledge Store. See your CA Clarity PPM administrator for access.

**Follow these steps:**
1. Open Home, and from Organization, click Knowledge Store.
   
   The Knowledge Store page appears.
2. Click the folder name.
   
   This action expands the folder tree so you can see the subfolders and documents beneath it.

**View the Document Manager**

The following procedures show how to see documents related to a specific project, program, or resource.

**Project**

**Follow these steps:**
1. Open the Home menu, and from Portfolio Management, click Projects.
   
   The list page appears.
2. Click the name of the project to view the Document Manager.
3. Click the Collaboration tab.
   
   The Document Manager page appears for the project.
Program

Follow these steps:
1. Open the Home menu, and from Portfolio Management, click Programs.
   The list page appears.
2. Click the name of the program to view the Document Manager.
3. Click the Collaboration tab.
   The Document Manager page appears for the program.

Resource

Follow these steps:
1. Open the Home menu, and from Resource Management, click Resources.
   The list page appears.
2. Click the name of the resource to view corresponding documents.
3. Click Document Manager.
   The Document Manager page for the resource appears.

Folders

Folders can stand alone and contain documents, or a folder can serve as a top-level folder that contains subfolders. Both top-level folders and subfolders can contain documents.

To view the list of folder actions, from a Knowledge Store or Document Manager page, click a folder Actions menu. Your access rights and permissions determine the actions that display.

If you do not have the appropriate access for a particular action, the action does not appear in the Actions menu for that folder.

Create a Folder

You can create subfolders for a top-level folder, and subfolders for a subfolder. When you create a subfolder, the application automatically gives read/write access to that subfolder to those resources you selected at the top level. These resources are named participants. You can select individual resources from the existing participant group and give access to additional users.
Follow these steps:

1. Open the Knowledge Store or the Document Manager page for a specific program, project, or resource.
2. Select New Folder from the folder Actions menu.
   The properties page appears.
3. Complete the following fields:
   - **Folder Name**: Defines the unique name for the folder.
   - **Access**: Defines the resources who have access to this folder. Select additional resources from a list of resources to which you have access. You can also remove an existing resource.
   Resources are automatically grouped as participants. You can grant them access to any of its subfolders as a group.
   - **Allow Non-participants to Access Folder**: Indicates if users not assigned to the project have access to project documents.
4. Click Save and Return.

Add a Document to a Folder

You can add a maximum of five files to a folder at one time. If you are adding files from a page in the Document Manager, choosing Add Documents from the folder Actions menu opens the add multiple documents page.

Follow these steps:

1. Open the Knowledge Store or the Document Manager page for a specific program, project, or resource.
2. Open the Actions menu, and click Add Documents from the folder.
   The Add Documents page appears.
3. Edit the following fields:
   - **Select Files**: Specifies the files are adding to the folder. At each field, click the Browse icon to attach a file.
   - **Limits**: Five files at one time
   - **Status**: Indicates if the documents are Approved, Rejected, or Submitted.
Category
Defines the document category. For example, select Proposal from the drop-down if the document is a proposal.

Date Created
Defines the document creation date. The date can be an actual creation date or the date you add the file to the folder.

Access
Indicates the type of access for this folder

Values
– All Participants. Indicates granting read/write access to this folder to all participants in the group.
Select Participants. Indicates that individual resources are from the existing participant group.

Default: All Participants selected.

Allow Non-participants to Access Folder
Indicates if users not assigned to the project have access to project documents.

Enable Check Out
Indicates if resources with appropriate access can check out and edit the file.

Enable Versioning
Indicates resources with appropriate access can create another version of the file.

Notify Resources/Groups
Indicates if resources who have access to the files are notified when documents are added.

Description
Defines the description of the files.

Comments
Specifies any comments about the files.

4. Click Add.
The selected documents are added to the folder.
Download Files from Folders

Use the Download All or the Incremental Download option to download files from a selected folder to a local zip file. The absence of these options on the Actions menu implies that you do not have the required permissions to perform the action.

You can download:

- All the files and subfolders in a selected folder
- A subset of files from the selected folder. The subset includes those files that have changed since you last downloaded and those not yet downloaded.

The zip file name is the name of the folder by default. You can select where to download the file. When you download files from a folder, the file structure is not maintained in the saved zip file.

**Important!** Enable the Enable Document Download setting before downloading files.

See the *Administration Guide* for more information.

Download All Files

Use the following procedure to download all the files selected, including files in subfolders.

**Follow these steps:**

1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Select Download All from the folder Actions menu.
   
   The File Download window opens.
   
   If the size exceeds the maximum for download set by your administrator, download a subset of files from the folder.
3. Click Save to save the zip file to a location on your computer.
   
   The Save As dialog opens.
4. Select the location, and click Save.
   
   The zip file is saved to the specified location on your computer.

Download Files Incrementally

Use the following procedure to download a subset of files from a selected folder. The zip file includes only files that have changed since you last downloaded them and files not yet downloaded.
The file structure is not maintained in the saved zip file.

**Follow these steps:**

1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Open the folder Actions menu, and click Incremental Download.
   The File Download window opens.
   If the size exceeds the document download maximum set by your administrator, download one file at a time.
3. Save to save the zip file to a location on your computer.
   The Save As dialog opens.
4. Select the location, and click Save.
   The zip file is saved to the location specified on your computer.

**Edit Folder Properties**

**Follow these steps:**

1. Open the Knowledge Store or the Document Manager page for a specific program, project, or resource.
2. Select Properties on the Actions menu of the folder to edit.
3. Edit the following fields, and save:
   - **Folder Name**
     Defines the unique folder name.
   - **Owner**
     Defines the owner for the folder.
   - **Access**
     Defines the level of folder access.

   **Options:**
   - **All Participants.** Indicates if read/write access is given to the participant group created when the top-level folder for this subfolder is created.
   - **Select Participants.** Indicates if individual resources are selected from the existing participant group.
Edit Folder Permissions

When you add resources to a folder, they are automatically grouped as participants with read/write access to this folder. The user who creates the folder is automatically given read, write, and delete access to the folder. You can change the permissions at any time.

Follow these steps:

1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Open the Actions menu, and click Permissions. The permissions page appears.
3. Select the permission you want to allocate to each resource.
4. To allow a resource to transfer the rights to any documents and subfolders in the current folder, select Cascade Permissions.
5. Save the changes.

Documents

While you can check out a document to edit it, you can also open it in read-only mode for viewing purposes only.

To view a document, select Open from the document Actions menu, and click Open when prompted on the File Download window. This option restricts your access to read-only for the document.

To save a document to your computer, select Open from the document’s Actions menu and click Save when prompted on the File Download window.

This option restricts your access to read-only for that document, just as opening the document for read-only restricts your access. To edit the document and save it back to the application, check out the document.

Check Out Documents

To edit a document, check it out of a folder. When you are finished, check the document back in. If document versioning is enabled, another version of the document is created automatically.

Other users cannot edit a checked-out document until you check it in. Enable the document for checkout before you can proceed.
Check Out

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click Check Out.
   The File Download window appears.
3. Save the document to your desktop, and select a location for the file.
4. Click OK.

Undo Checkout

Only the user who checked out the document originally can undo a checkout. Performing this action unlocks the document, allowing others to check out the document.

Select Undo Check Out from the document Actions menu to undo a document check-out status.

Check In

Click Check-in from the document Actions menu and browse for the updated copy in the location selected when you checked out the document.

Copy a Document

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document to copy to a different folder, and from the document Actions menu, click Copy.
   A page appears for selecting the destination folder.
3. In the Select Placement section, select the destination folder.
4. Select the Notify Resources/Groups check box for users with access to this document notified about the copy action.
5. Click Copy.
Edit Document Properties

The user who added the document can update the document properties.

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click Properties. The properties page appears.
3. Edit the available fields, and save.

Edit Document Permissions

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, Permissions. The permissions page appears.
3. Select the permission to allocate to a resource. Values include Read, Read/Write, and Read/Write/Delete.
4. Save the changes.

Review Document History

The Document History page lists the names of the users who have accessed the document and the date and time of their most recent visit.

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click History. The history page appears.
3. Click Return when done.
Move a Document to a Different Folder

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click Move.
   A page appears for selecting the destination folder.
3. Select the folder to move the document to.
4. Click Move.

Work with Document Versions

Use document versioning to save a separate version of a document each time you check it in. To use document versioning, enable the document for versioning.

Open Previous Document Versions

You cannot modify a previous version of a document, but you can open and view it.

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click Versions.
   The document versions page appears and lists all the versions of the document.
3. Open the document version Actions menu, and click Open.
   The file download window appears.
4. Click Open.

Copy a Document Version to a Different Folder

You can copy a specific version of a document to a different folder. If you do this, you require revising the document permissions after copying it.

Follow these steps:
1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, from the document Actions menu, click Versions.
   The document versions page appears and lists all the versions of the document.
3. Open the document version Actions menu, and click Copy.
   The copy document page appears.
4. Select the folder to copy the document to, and click Copy.

**Work with Document Processes**

If your CA Clarity PPM administrator has created document-related processes, they are listed on the available processes page. Document processes can be effective when routing a document through an approval process. Processes are effective because a document process can link to any associated project or program. You can send notifications and action items from the document process to the project roles and resources.

*Note:* See the *Administration Guide* for more information.

The initiated processes page of document lists the in-progress or completed processes. To view the page, open the Knowledge Store, and from the document Actions menu, click Processes.

The steps for starting, stopping, and deleting document processes from a Document Manager page are similar to the steps described in this section.

**Start a Document Process**

*Follow these steps:*

1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click Processes.
   The list of initiated processes appears.
3. Click the Available tab.
   The list page appears.
4. Select the process to start, and click Start.

**Cancel a Document Process**

The initiated processes page of document lists the in-progress or completed processes. To stop a document process, select the process to stop, and click Cancel Process. The application stops the process.
Delete a Process

You can delete completed or canceled processes but not processes that are running.

Follow these steps:

1. Open the knowledge store or the document manager page for a specific program, project, or resource.
2. Locate the document, and from the document Actions menu, click Processes. The list of initiated processes appears.
3. Click the Available tab. The list of available processes appears.
4. Select the process, and click Delete. A confirm process instance delete page appears.
5. Click Yes to confirm the deletion.
Chapter 7: Global Search Tool

This section contains the following topics:

- About the Global Search Tool (see page 71)
- Perform a Basic Search (see page 71)
- Perform an Advanced Search (see page 72)
- Global Search Techniques (see page 73)

About the Global Search Tool

The Global Search tool appears on the global toolbar. Use the global search field to perform a simple global search to look for specific documents and forms. Use the Advanced link to perform an advanced search to set additional search criteria to refine your search results.

You can search for information saved in the application at any time. However, by default, five minutes to elapse before new information can be searched. The amount of time is determined and can be changed by your administrator.

See the Administration Guide for more information.

Perform a Basic Search

To perform a basic search, click the Search icon and enter all or part of the term, then click Search. The search results page appears displaying a list of all items that match the criteria specified. It the list contains only items you have the right to view.

Keep in mind these guidelines when entering terms in the global search field:

- To perform a wildcard search, enter all or part of the search criteria. You do not need to append your entry with a wildcard character (*). Basic search is not case-sensitive. For example, the entries Orange, orange, and ORANGE all return the same results.

- If you enter the search phrase, Resource Profile List, without quotations, the application searches for items that contain any of these words in any order. However, if you enter the search phrase in quotation marks ("Resource Profile List"), only instances of the exact string are returned.

- Do not use the following characters in basic searches:
  
  @ = [] {} <>
Perform an Advanced Search

Use the Advanced Search page to set additional criteria to refine your search results.

Use the fields and options on the page to narrow your search. You can search according to one or any combination of the criteria. Search results display only for those items you have permissions to view or edit.

Follow these steps:
1. On the global menu, click the Search icon, then click the Advanced link.

   The Advanced Search page appears.

2. In the General section, enter the following:

   **Text**
   
   Defines the text to search. To perform a wildcard search, enter an asterisk (*) at the end of the text. Searches are not case-sensitive.

   **Mode**
   
   Specifies the mode of searching.
   
   **Values:** All Words, Any Words, or Exact Phrase

   **Owner**
   
   Specifies the owner type.
   
   **Values:** All Owners or Selected Owners

   **Created Date**
   
   Defines the date of creating the item being searched. You can enter a range of From Date and To Date.

   **Modified Date**
   
   Defines the date of modifying the item being searched. You can enter a range of From Date and To Date.

3. In the What to Search section, enter the following:

   **Documents**
   
   Specifies the type of document being searched.
   
   **Values:** All, None, or a specific type

   **Include File Contents**
   
   Indicates if the search results include the document contents.

   **Include Prior Versions**
   
   Indicates if the search results include a prior version of a document.
Global Search Techniques

Action Items
Indicates if the search results include action items.

Discussions
Indicates if the search results include discussions.

4. In the Where to Search section, for Areas to Search, select the check box of each CA Clarity PPM module. For example, Knowledge Store or Resources.

5. Click Search.
   The search results page displays a list of all items that match the criteria you specified. Only items that you have the right to view appear in the results.

6. Do one of the following:
   - To perform another advanced search, click Revise Search.
     The advanced search page appears where you can revise the fields.
   - To return to the Overview: General page, click Return.

Global Search Techniques

Use the following techniques for performing global searches:
- Wildcard characters
- Boolean operators
- Subqueries

Use Wildcard Characters in a Global Search

With the Global Search tool, you can perform single and multiple character wildcard searches. Do not use the "*" or "?" symbols as the first character of a search.

Single Character Wildcard Search
The single character wildcard search looks for terms that match that with the single character replaced. To perform a single character wildcard search, use the "?" symbol.

Example: To search for text or test, enter the query: te?t

Multiple Character Wildcard Search
Multiple character wildcard searches look for zero or more characters. To perform a multiple character wildcard search, use the "*" symbol.
Example: To search for test, tests, or tester, enter the following:

`test*`

You can also use wildcard searches in the middle of a term.

Example:

`te*t`

Use Boolean Operators in a Global Search

Boolean operators allow you to perform global searches using multiple terms that are combined through logic operators. The following Boolean operators are supported: AND, +, OR, NOT, and -.

Enter Boolean operators in all caps.

OR

OR is the default conjunction operator, which means no Boolean operator exists between two terms, OR is used. The OR operator links two terms and finds a matching document if either of the terms exist in a document. This operation is equivalent to a union using sets. You can use the symbol || in place of the OR operator.

Example: To search for documents that contain "jakarta apache" or "jakarta", use the query:

"jakarta apache" "jakarta"

or,

"jakarta apache" OR "jakarta"

or,

"jakarta apache" || "jakarta"

AND

The AND operator matches documents in which both terms exist anywhere in the text of a single document. This operation is equivalent to an intersection using sets. You can use the special character && in place of the AND operator.

Example: To search for "jakarta apache" and "jakarta CA Clarity PPM", use the query:

"jakarta apache" AND "jakarta CA Clarity PPM"

or,

"jakarta apache" && "jakarta CA Clarity PPM"
Global Search Techniques

Chapter 7: Global Search Tool

+ (required)

The +, or required, operator requires that the term after the + operator to exist somewhere in a field of a single document or form.

Example: To search for documents containing "jakarta" with or without "CA Clarity PPM", use the query:

+"jakarta CA Clarity PPM"

NOT

The NOT operator excludes documents or forms that contain the term after the NOT operator. You can use the symbol ! in place of the NOT operator.

Example: To search for documents that contain "jakarta apache" but not "jakarta CA Clarity PPM", use the query:

"jakarta apache" NOT "jakarta CA Clarity PPM"
or,

"jakarta apache" ! "jakarta CA Clarity PPM"
The NOT operator cannot be used with a single term. This query returns no results:

NOT "jakarta apache"

- (prohibit)

The -, or prohibit, operator excludes documents that contain the term after the - operator.

Example: To search for documents and forms that contain "jakarta apache" but not "jakarta CA Clarity PPM", use the query:

"jakarta apache" - "jakarta CA Clarity PPM"

Form Subqueries in a Global Search

Subqueries allow you to control the Boolean logic during global searches by grouping clauses with parentheses. For example, to search for documents and forms that contain either "jakarta" or "apache" and "website", include the following sub query in the query:

("jakarta" OR "apache") AND "website"
The preceding query helps ensure that "website" exists and that either term, "jakarta" or "apache", possibly exist.

Escape Special Characters in Global Searches

Escape special characters in global searches properly. To escape these characters, use the "\" (backslash) character before the special character. For example, to escape the special characters in a global search for (1+1):2, use the following query:

\(1\text{\textbackslash}\text{+1}\):2
The following table lists the special characters:

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Description</th>
<th>Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>plus sign</td>
<td>+</td>
</tr>
<tr>
<td>-</td>
<td>minus sign</td>
<td>-</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>double ampersand</td>
<td>&amp;&amp;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>exclamation point</td>
<td>!</td>
</tr>
<tr>
<td>(</td>
<td>left parenthesis</td>
<td>(</td>
</tr>
<tr>
<td>)</td>
<td>right parenthesis</td>
<td>)</td>
</tr>
<tr>
<td>{</td>
<td>left curly brace</td>
<td>{</td>
</tr>
<tr>
<td>}</td>
<td>right curly brace</td>
<td>}</td>
</tr>
<tr>
<td>[</td>
<td>left square bracket</td>
<td>[</td>
</tr>
<tr>
<td>]</td>
<td>right square bracket</td>
<td>]</td>
</tr>
<tr>
<td>^</td>
<td>circumflex</td>
<td>^</td>
</tr>
<tr>
<td>&quot;</td>
<td>quotes</td>
<td>&quot;</td>
</tr>
<tr>
<td>~</td>
<td>tilde</td>
<td>~</td>
</tr>
<tr>
<td>*</td>
<td>asterisk</td>
<td>*</td>
</tr>
<tr>
<td>?</td>
<td>question mark</td>
<td>?</td>
</tr>
<tr>
<td>:</td>
<td>colon</td>
<td>:</td>
</tr>
<tr>
<td>\</td>
<td>backslash</td>
<td>\</td>
</tr>
</tbody>
</table>
Chapter 8: Timesheets

This section contains the following topics:

- Timesheet Overview (see page 77)
- How to Work with Timesheets (see page 77)
- Access an Unsubmitted Timesheet (see page 78)
- How to Add Tasks to a Timesheet (see page 78)
- Enter Work Hours into a Timesheet (see page 80)
- Specify Entry Input Type and Charge Codes (see page 81)
- Split Entry Input Type Codes and Charge Codes (see page 81)
- Time Entry ETC (see page 82)
- Submit a Timesheet for Approval (see page 82)
- Edit a Timesheet Before Approval (see page 83)
- Timesheet Notes (see page 83)
- Email from Within a Timesheet (see page 85)
- How to Correct a Returned Timesheet (see page 85)
- Print a Timesheet (see page 86)

Timesheet Overview

You can access your current timesheet, record actuals, and manage your timesheets. You can record time booked on assignments: tasks, indirect work, and time allocated to other activities.

You can complete a timesheet on a daily, weekly, bi-weekly, or even monthly basis. You enter time into cells on a timesheet for each day of the week, for each timesheet period. If you work the same number of hours daily for a task, you can add tasks to duplicate your timesheets.

How to Work with Timesheets

Use the following process to work with timesheets:

1. Access your unsubmitted timesheet (see page 78).
2. Populate your timesheet (see page 78).
3. If necessary, add entries to your timesheet (see page 78).
4. Enter work hours into your timesheet (see page 80).
5. If applicable, specify input type and charge codes for your timesheet entries (see page 81).
Access an Unsubmitted Timesheet

6. **If necessary, add notes to your timesheet or timesheet tasks** (see page 83).
7. **Submit your timesheet for approval** (see page 82).

### Access an Unsubmitted Timesheet

**Follow these steps:**

1. Open Home, and from Personal, click Timesheets.
   - The timesheets list page appears with the unsubmitted timesheets up to the current reporting period.
2. Click the Timesheet icon next to the timesheet.
   - The timesheet page appears.

### How to Add Tasks to a Timesheet

When you open a timesheet for the first time, it contains no timesheet entries. Before you enter time, add the tasks you work on to your timesheet.

Adding tasks to timesheets adds time entries to timesheets. You can manually add time entries to your timesheet or you can pre-populate the timesheet.

### Populate a Current Timesheet

Use the Populate button on the timesheet page to prepopulate your current timesheet with your assigned tasks. You can adjust your current timesheet as needed. Depending on how your administrator has set up your timesheet options, prepopulating a timesheet performs one of the following:

- Copies the timesheet entries and actuals from the most recently submitted timesheet into your current timesheet.
- Copies all of your assignments into the timesheet.

Prepopulating the current timesheet does not copy assignments whose finish dates precede the start date of the current timesheet. For example, consider a timesheet period of 12/03/11 to 12/09/11. If the finish date of an assignment is 11/30/11, the assignment does not display on your current timesheet. If you want to add the assignment to your timesheet, add the task manually. If you did not work on all of the assignments, delete the tasks that you did not work on.
Add Entries to a Timesheet Manually

To add timesheet entries to your timesheet manually, use the Add Task, Add Other Time, and Add Indirect Row buttons. These buttons display on the timesheet page. To view the page, open your timesheet.

You can add a task to your timesheet for time spent on assignments that are not in the project plan. Use indirect timesheet entries when you want to log time directly against a charge code. Indirect timesheet entries contain predefined, general descriptions and input type codes. You can select the indirect entry that best suits the work you performed.

The time you spend on indirect task entries is not counted as part of the project plan. The project manager converts the indirect entry into a project task by adding it to the project plan.

Follow these steps:

Project Task Entries

Click Add Task. Newly added tasks display under the Tasks category in the timesheet list.

Other Time

Click Add Other Time. Newly added rows display under the Other Time category in the timesheet list.

Incidents associated to an investment

Click Add Incident. Newly added incidents display under the Incidents category in the timesheet list.

Indirect timesheet entries

Click New Indirect Row. Newly added indirect entries display under the Indirect category in the timesheet list.

Add a Task Entry to a Timesheet

Newly added task entries display under the Tasks category in the timesheet list.

You can delete time entries from your timesheet before submitting the timesheet. Deleting time entries removes the time entry from your timesheet but does not delete the task from the project.

Follow these steps:

1. With your timesheet open, click Add Task.

   The select tasks page displays.
2. Do one of the following:
   - Select the check box next to the desired tasks and click Add to add your selection and return to the Timesheet page.
   - Select the check box next to the tasks, and click Add and Select More. This adds your selections and returns to the task list to select additional tasks. After adding all your tasks, click Cancel to return to the timesheet page.

   The timesheet page is populated with the tasks selected.

Add Indirect Row Timesheet Entries to a Timesheet

Indirect row timesheet entries display under the indirect category in the timesheet list.

**Follow these steps:**

1. With your timesheet open, click New Indirect Row.
   A new entry is created.
2. If your company uses Charge Codes or Input Type Codes, select them.
3. Save the changes.

Enter Work Hours into a Timesheet

Use the current period for the timesheet page to record the time you worked each day on task assignments. Enter timesheet information for a non labor resource the same way you do for a labor resource. Timesheet actuals are generated from the approved hours staff members record on their timesheets.

You can also distribute the number of hours for a single task evenly across all working days (typically based on a five-day workweek). Enter the total number of hours you worked in the Total column for the time entry row and save the timesheet.

If you enter values in both the Date and Total cells, the Date cell value overrides the Total cell value.

Timesheets are temporarily locked when you save them. The timesheet unlocks when the save is complete. The temporary lock prevents two users from updating a timesheet at the same time. If you attempt to save a previous version of a timesheet, an alert message appears. Close and reopen the timesheet to display the most recent version.
Follow these steps:

1. Open the timesheet.
   The timesheet page appears.
2. Enter the number of hours you worked on each assignment each day in the Date cells of the timesheet.
3. Save the changes.

Specify Entry Input Type and Charge Codes

Input type and charge codes are used for payroll purposes. If your company uses input type or charge codes, your project manager can make the codes available to you to use in your timesheets. Verify the policy of your company on input type and charge codes before submitting your timesheets.

See the *Project Management User Guide* for more information.

Follow these steps:

1. Open the timesheet.
   The timesheet page appears.
2. Select an input type code or charge code from the Input Type Code or Charge Code drop-down for the desired time entry row.
3. Save the changes.

Split Entry Input Type Codes and Charge Codes

You can split the time you work on an assignment between multiple input type codes and charge codes.

Your project manager creates and defines the input type codes and charge codes.

See the *Project Management User Guide* for more information.

Example

Record four hours on an assignment to an input type code, and four hours on the same assignment to a different input type code. If your company uses both type and charge codes, you can split an entry between both.
Follow these steps:

1. Open the timesheet.
   The timesheet page appears.
2. Select the check box next to the timesheet entry you want to split, and click Split.
   A new timesheet row appears beneath the one you selected.
3. In the new timesheet entry row, select a type code or charge code from the Input Type Code or Charge Code field.

**Time Entry ETC**

The Estimate to Completion (ETC) indicates how much time is expected to complete a project task. Project managers can enter this value when they set up their project. If they do so, you can view this value in the ETC column for the time entry row on your timesheet. The ETC changes each week according to the actuals you entered the previous week. The ETC value indicates the number of expected hours left to complete the task. For example, an ETC value of 60 means that an estimated 60 more work hours are required to complete the task or assignment.

You can edit the ETC, but only change the ETC if you complete the assignment ahead of schedule, or if you need more hours. When you change the ETC, it is in a pending state. The pending ETC is used until the project manager accepts or rejects the new value. If the ETC displays a zero (0) for the time entry row, the project manager has decided not to accept the new value.

**Submit a Timesheet for Approval**

When you submit a timesheet, it goes to your manager for approval. The status of the timesheet is "Unapproved" until your manager approves it.

**Follow these steps:**

Do one of the following:

- From the timesheets list page, select the timesheet, and click Submit for Approval.
- Open the timesheet, and click Submit for Approval.
**Edit a Timesheet Before Approval**

You can edit the timesheets submitted but unapproved.

**Follow these steps:**
1. Open the timesheet.
   The timesheet page appears.
2. Edit the timesheet, and save or submit for approval.

**Timesheet Notes**

You can add a note to a timesheet to create a reminder for yourself, or to communicate with the project manager at two levels:
- Entire timesheet
- Single timesheet entry

Notes appear in the order in which they are created, with the most recent note appearing at the top of the list. You can access and read notes by clicking the Time Entry Note icon in the time entry row.

You can delete your notes.

**Add a Note to a Task Entry**

Use the following procedure to add notes to task entries or timesheets.

**Follow these steps:**
1. Open the timesheet.
   The timesheet page appears.
2. Click the Time Entry Notes icon for a timesheet entry.
   The time entry notes window opens.
3. Enter the following:
   - text for the note
   - category for the note (optional)
4. Click Add.
   The new note appears in the time entry notes window.
5. Click Return.
Add a Note to a Timesheet

Follow these steps:

1. Open the timesheet.
   The timesheet page appears.
2. Click the Timesheet Notes icon next to the Time Period field.
   The timesheet notes window opens.
3. Enter the following:
   - text for the note
   - category for the note (optional)
4. Click Add.
   The new note appears in the time entry notes window.
5. Click Close to return to the timesheet page.
   To view a note for a timesheet entry, click the Time Entry Notes icon for the corresponding timesheet entry.

Edit a Timesheet or Time Entry Note

You cannot send a reply to a note, but you can edit notes added to your timesheet or timesheet entries. You can edit only the time entry notes that you create. Existing notes for a timesheet show a page icon with horizontal lines. If the page icon is a blank page, no note has been added.

Follow these steps:

1. Open your timesheet.
2. Do one of the following:
   - Click the Timesheet Notes icon at the top right of the page.
   - Click the Time Entry Notes icon that displays next to each task.
3. Click the Edit Note icon next to the note.
   The timesheet or time entry note opens.
4. Edit the note, and save your changes.
Email from Within a Timesheet

If someone else modifies your timesheet, the name of the person appears in the Modified by field on your timesheet.

The project manager can also send emails to you from within a timesheet by clicking the Send To icon that appears next to your name.

Follow these steps:
1. With your timesheet open, do one of the following:
   - Click the Send Mail icon that appears next to the Resource Name and the Modified by name fields
   - Click the Send Mail icon that appears next to name of your manager
   An email message opens in your default email application, with the name of the recipient appearing in the To field.
2. Send the email.

How to Correct a Returned Timesheet

When your project manager returns a timesheet, you receive a notification. The method in which you are notified depends on the settings specified on your notifications page of account settings. For notification by email, you can access and open your timesheet from the URL within the email notification.

If the project manager returns a timesheet to you for correction, use the following process to correct the timesheet:
1. Access your timesheet (see page 78).
2. If the project manager has added a note about an error on a timesheet entry, access and read the note (see page 83).
3. Make corrections to your timesheet as needed (see page 83).
4. Submit your timesheet for approval (see page 82).
   The project manager is notified that the corrected timesheet is ready for review and approval.
Print a Timesheet

Follow these steps:

1. Open the timesheet.
   The timesheet page appears.

2. Click the Printable Version link that appears at the top right and bottom right of the page.
   A new timesheet window opens with a read-only version of the timesheet.

3. Use your print command from the browser to print the timesheet.
Chapter 9: Reports and Jobs

This section contains the following topics:

- Reports Overview (see page 87)
- Jobs Overview (see page 95)

Reports Overview

Reports are documents that organize and display extracted CA Clarity PPM information. With reports, you can capture and analyze information related to your work. You can run and view out-of-the-box reports or reports designed for your specific needs.

About Report Security

Security for reports has three levels. The following levels describe what occurs at each level of access. The CA Clarity PPM administrator grants you access rights to specific features.

Report access

This access level lets you view reports. When you have access at this level, you can open the available reports page. The Reports - Access right includes this level of access.

You can be granted instance access rights to view and run a specific report. The Report - Run access right lets you run a report and view the output. This access right does not let you change the parameters that filter information for a report.

Report definition

This access level lets you edit a specific report definition. When you have this level of access, you can change the report parameters to filter information for a report. The Reports and Jobs - Edit Definition instance access right lets you edit a specific report definition.

Row-level security within a report

This access level helps ensure that information is provided to you if you have the right to view the information. The row content that appears in each report varies depending on the access rights you have to items contained in the report. For example, if you run a report that lists information for multiple projects, only those projects to which you have rights appear in the report.
Jobs Affecting Report Information

The Setup and Update Data Used by Reports and Time Slicing jobs generate report information. If these jobs fail, reports can be affected. If report information does not display, it implies that one of the jobs have failed to run.

Contact your CA Clarity PPM administrator or see the Administration Guide for more information.

Run or Schedule a Report To Run

You can run and view reports from the available reports page. You cannot delete or remove available reports.

If you have personalized the overview page to display the My Reports portlet, you can run reports from this portlet.

Contact your CA Clarity PPM administrator or see the Administration Guide for more information.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Specify the filter criteria, or click Show All to view a list of all available reports.
3. Click the name of the report to execute.
   The properties page appears.
4. Define the run properties for the report, and save the changes.

Scheduled Report Runs

Scheduled report runs provide the ability to set up recurring schedules for your frequently viewed reports. By scheduling the reports to run in advance, the updated reports are available when you need them.
Define or Edit Scheduled Report Run Properties

You can edit the properties of scheduled report runs that have the "Cancelled" or "Completed" status using the report properties page. Otherwise, you can only view report run properties.

Report run properties include scheduling and notification information, and any parameters that you can customize.

**Note:** If a report is scheduled to run only once, you can only edit its properties before the scheduled run time.

**Follow these steps:**

1. Open Home, and from Personal, click Reports and Jobs.
   
   The list page appears.

2. If you are editing the schedule of an existing report run, open the Reports menu, and click Scheduled Reports.
   
   The scheduled reports page appears.

3. Click the name of the report to define or edit the run properties.
   
   The properties page appears.

4. In the General section of the page, complete the following field:

   **Report Name**

   Defines the name of the report to run. For scheduled runs, a display-only report ID and its status are displayed.

5. In the Parameters section, complete the following fields:

   **Parameters**

   Specifies the parameters used to run the report. The parameters that appear vary based on the report displayed. If this section does not appear, then your administrator did not define parameters.

6. In the When section, choose when you want to run the report:

   **When**

   Defines the interval on which the report runs.

   **Values:**

   - Immediately. Select to run the report now.
   - Scheduled. Select to schedule the report to run later. Then complete the following fields:
**Start Date**
Defines the date of running the report.

**Required:** Yes

**Start Time**
Defines the start time in hours and minutes.

**Recurrence**
Defines the recurrent run time. You can set a recurrence, such as weekly or monthly, by clicking the Set Recurrence link. You can also set the recurrence of a scheduled report by using UNIX crontab format entry. To use crontab to set the recurrence, click Use UNIX Crontab Entry Format, and enter the schedule.

7. Click Set Recurrence to specify a repeating run time for the report, and complete the following fields:

- Run Once
  Indicates if this scheduled occurrence only occurs once.

- Weekly
  - On. Defines the day of the week (Sunday through Saturday) on which the report run starts.
  - Months. Defines the month (January through December) on which the report run starts.
  - Recur Until. Defines the date until which the report run is to recur.

- Monthly
  - Days of the Month (1-31). Defines the specific day (range 1-31) each month on which the report run is to start.
  - Months. Defines the month (January through December) on which the report run starts.
  - Recur Until. Defines the date until which the report run is to recur.

- Use UNIX crontab entry format
  Defines the schedule in UNIX Crontab entry format. Go to Oracle docs.sun.com for more information about the UNIX crontab syntax format and special character usage.

  **Example:** 0 0 1, 15 * * runs the report at midnight on the 1st and 15th of every month.
8. Complete the following fields in the Notify section:

Resource to Notify on Failure
Specifies the users who receive report status notifications when the report run fails.

Resource to Notify on Completion
Specifies the users who receive report status notifications when the report run successfully completes.

Groups to Notify on Failure
Specifies the groups who receive report status notifications when the report run fails.

Groups to Notify on Completion
Specifies the groups who receive report status notifications when the report run successfully completes.

Note: If a report fails, check the status of scheduled runs for additional information or contact your administrator for assistance.

9. Save and submit the changes.

View the Status of a Scheduled Report Run

You can check report scheduled run times and check report run statuses using the scheduled reports page. All scheduled report runs (except the deleted reports) appear in the list regardless of their status.

Scheduled report runs can have the following statuses:

- Cancelled. The scheduled run is stopped and future recurring runs permanently cancelled.
- Completed. The single, nonrecurring scheduled run is complete and the generated report output is available.
  Recurring scheduled runs never show a "Completed" status.
- Paused. The scheduled run is stopped temporarily.
- Running. The scheduled run is in progress.
- Scheduled. The scheduled run starts generating the report on its prescribed date and time.
- Waiting. The scheduled run cannot start generating the report until an incompatible report or job run is completed.
**Follow these steps:**

1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Open the Reports menu, and click Scheduled Reports.
   The scheduled reports page appears.

**Delete a Scheduled Report Run**

You can delete scheduled runs with a "Cancelled" or "Completed" status. Deleting a scheduled run does not delete the report type, or any completed generated reports listed in the Reports Library.

**Follow these steps:**

1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Open the Reports menu, and click Scheduled Reports.
   The scheduled reports page appears.
3. Select the check box next to the run, and click Delete Job.

**Add a Report to the My Reports Portlet**

If you have personalized the Overview page to display My Reports portlet, you can add any available report and run reports from the page.

**Follow these steps:**

1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click the name of the report to add.
   The properties page appears.
3. Click Add to My Reports.
   The report is added to the My Reports portlet on the Overview page.
**View a Generated Report**

Use the report library page to review generated report output to which you have access or to view the run properties of generated reports. You must have Adobe Acrobat Reader installed to view reports. Requires the view permission for a report to view the report in the report library page.

If you ran the report immediately, the output appears in a separate window. Otherwise, if you scheduled the run, you can access the report output from the report library page.

**Note:** For reports that run immediately, you have the option to view the report immediately. You can also save the report and view it later from the report library page.

**Follow these steps:**

1. Open Home, and from Personal, click Reports and Jobs.
   
   The list page appears.

2. Open the Reports menu, and click Report Library.
   
   The report library page appears.

3. Do one of the following:
   
   ▪ Click the Open Report icon next to the report to review.
   
   The report output appears.

   ▪ Click the Report link to view run properties.

**Delete Generated Reports**

You can delete generated reports as needed. Also, request the Remove Job Logs and Report Library entries job run to periodically remove outdated reports from the Reports Library.

See the Administration Guide for more information.

**Follow these steps:**

1. Open Home, and from Personal, click Reports and Jobs.
   
   The list page appears.

2. Open the Reports menu, and click Report Library.
   
   The scheduled reports page appears.

3. Select the check box next to the report, and click Delete.
Pause or Resume Scheduled Report Runs

Pausing scheduled report runs temporarily stops the report from running. When in this state, the report cannot run at its scheduled time until you resume the report run. When you resume the report runs, it runs at its next scheduled run time. You can pause reports that have a "Scheduled" status.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Open the Reports menu, and click Scheduled Reports.
   The scheduled reports page appears.
3. Select the check box next to the scheduled report run, and do one of the following:
   - Click Pause.
     The status of the report run changes to "Paused".
   - Click Resume.
     The status of the report run changes to "Scheduled". The report runs at the next scheduled time.

Cancel Scheduled Report Runs

Canceling scheduled runs stops the run immediately and cancels any future runs. A cancelled run remains listed on the scheduled reports page with a status "Cancelled" status. Once you cancel a run, you cannot change its status or edit any of its properties.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Open the Reports menu, and click Scheduled Reports.
   The scheduled reports page appears.
3. Select the check box next to the scheduled run, and click Cancel Job.
   The status changes to "Cancelled".
Jobs Overview

Jobs Overview

Jobs are sets of actions used by CA Clarity PPM to perform automated administrative processes on a regular basis. For example, populating or refreshing database tables and running background processes. A job can be composed of queries, statements, or procedures.

See the Administration Guide for more information.

Run or Schedule a Job to Run

Run or Schedule a Job to Run

You can view a list of all the jobs that you have access to. You can run a job immediately or schedule it to run later using the available jobs page.

Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click Jobs.
   The list page appears.
3. Click the name of the job.
   The properties page appears.
4. In the When section, complete the following field, and save:

   When
   Defines the interval on which the job runs.

   Values:
   - Immediately. Select to run the job now.
   - Scheduled. Select to schedule the job to run later, and complete the following fields:

   Start Date
   Defines the date for running the job.

   Required: Yes

   Start Time
   Defines the start time in hours and minutes.
Recurrence

Defines the recurrent run time. To set a recurrence, such as weekly or monthly, click the Set Recurrence link. To set the recurrence of a scheduled job, use UNIX Crontab Format Entry. To use Crontab to set the recurrence, select Use UNIX Crontab Entry Format and enter the schedule.

**Example:** 0 0 1, 15 * * means run the job at midnight on the 1st and 15th of every month.

Scheduled Job Runs

Use the scheduled job page to check the run times of a job and to check the run status. All scheduled runs (except deleted ones) are listed regardless of their status.

Use the scheduled jobs page to view the status of scheduled runs.

A scheduled run can have one of the following statuses:

- **Cancelled.** The scheduled run was stopped and future recurring runs permanently cancelled.
- **Completed.** The single, non-recurring scheduled run has completed. If the job definition is set to generate a log, you can view it in the Job Log.
  
  **Note:** Recurring scheduled runs never show a status of "Completed".
- **Paused.** The scheduled run is stopped temporarily.
- **Running.** The scheduled run is in progress.
- **Scheduled.** The scheduled run starts executing the job on its prescribed date and time.
- **Waiting.** The scheduled run has reached its scheduled run date and time, but cannot start executing the job until an incompatible report or job completes running.

Define or Edit Scheduled Job Run Properties

Using the job properties page, edit the properties of scheduled job runs that have a "Cancelled" or "Completed" status. Otherwise, you can only view job run properties.

**Note:** If you schedule a job to run only once, you can edit its properties before the scheduled run time.
Follow these steps:

1. Open the job.
   The properties page appears.

2. In the General section, complete the following fields:
   
   **Job Name**
   Defines the name of the job. For scheduled runs, you can change the name to distinguish each instance of a run.
   
   **Example:** Retailing Banking - Monthly Rate Extraction run

   **Job ID**
   Displays the unique identifier for a scheduled job.

   **Job Status**
   Displays the status for a scheduled job.

3. Complete the fields in the Parameters section.

   **Note:** The parameters that display vary based on the job. If this section does not display implies your CA Clarity PPM administrator defined no parameters. Save the parameters to reuse the defined set of parameters. Saved parameters appear in the list on the available jobs list page below the job type.

4. Complete the following fields, and save:
   
   **When**
   Defines the interval on which the job runs.

   **Values:**
   - Immediately. Select to run the job now.
   - Scheduled. Select to schedule the job to run later, and complete the following fields:

   **Start Date**
   Defines the date for running the job.

   **Required:** Yes

   **Start Time**
   Defines the start time in hours and minutes.
Recurrence
Defines the recurrent run time. To set a recurrence, such as weekly or monthly, click the Set Recurrence link. To set the recurrence of a scheduled job, use UNIX Crontab Format Entry. To use Crontab to set the recurrence, select Use UNIX Crontab Entry Format and enter the schedule.

Example: 0 0 1, 15 * * means run the job at midnight on the 1st and 15th of every month.

5. Complete the following fields in the Notify section:

   Resources to Notify on Failure
   Specifies the resources to notify on failure.

   Groups to Notify on Failure
   Specifies the groups to notify on failure.

   Resources to Notify on Completion
   Enter a resource name in the field or use the search tool to select the name from a resource list.

   Groups to Notify on Completion
   Enter the name of the group to notify in the field or use the search tool to select the group from a list.

6. Complete the following fields in the Sharing section:

   Resources
   Specifies the users who can view the generated report.

   Groups
   Specifies the groups who can view the generated report.

Pause or Resume a Scheduled Job Run

On the scheduled jobs page, you can pause any job with a "Scheduled" status, and resume any paused job. You can pause a run to stop temporarily a job from running. When in this state, the job cannot run at its scheduled time until you resume the job. When you resume a job, it runs at its next schedule run time.
Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click Jobs.
   The available jobs list appears.
3. Open the Jobs menu, and click Scheduled Jobs.
   The scheduled jobs list appears.
4. Select the check box next to the scheduled run, and do one of the following:
   a. Click Pause.
      The status for the job run changes to "Paused".
   b. Click Resume.
      The status for the job run changes to "Scheduled". The job runs at the next scheduled time.

View the Status of a Scheduled Job Run

Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click Jobs.
   The available jobs list appears.
3. Open the Jobs menu, and click Scheduled Jobs.
4. Browse for or filter the scheduled runs.
   The jobs display in the list.
5. Check their status.
Cancel a Scheduled Job Run

You can cancel a schedule job run from the scheduled jobs list page. Canceling a scheduled job run stops the job immediately and cancels any future runs. A canceled run remains in the scheduled jobs list with a "Canceled" status. Once you cancel a job run, you cannot change its status, or edit any of its properties.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click Jobs.
   The list of available jobs appears.
3. Open the Jobs menu, and click Scheduled Jobs.
   The scheduled jobs page appears.
4. Browse for or filter the scheduled runs.
   The jobs display in the list.
5. Select the check box next to the scheduled run, and click Cancel Job.
   The status of the scheduled job changes to "Canceled."

View the Job Log

Use the jobs log page to view information about a job run, or delete outdated job logs.

A job log consists of a read-only version of its run properties and lists job entries, times, and any messages. If a job fails, the log indicates the nature of the error.

You can also schedule the Remove Job and Library job to remove job logs and report instances periodically from the Report Library or Job Log.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click Jobs.
   The available jobs list appears.
3. Open the Jobs menu, and click Log.
   A list of jobs with log entries appears.
4. Click the name of the job.
   The job log displays.
Delete a Scheduled Job Run

Using the scheduled jobs page, you can remove scheduled job runs with a "Cancelled" or "Completed" status. Removing scheduled runs does not delete the job type, or any of the job logs of the run.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
   The list page appears.
2. Click Jobs.
   The available jobs list appears.
3. Open the Jobs menu, and click Scheduled Jobs.
   The scheduled jobs page appears.
4. Select the check box next to the scheduled run, and click Delete Job.
Chapter 10: Account Settings

This section contains the following topics:

How to Manage Your Account (see page 103)
Manage Your Personal Information (see page 103)
Update Your Password (see page 105)
Designate Proxies (see page 106)
View Your List of Proxies (see page 106)
Notifications Setup (see page 107)
Software Downloads (see page 109)
Download Software (see page 110)

How to Manage Your Account

Use the account settings pages to change elements of your resource profile, assign your action items to a different user, and to download software. Use the personal information page to manage your account settings.

You can do the following to manage your account settings:

- Manage your personal information (see page 103).
- Update your password (see page 105).
- View a list of proxies (see page 106).
- Update your proxy settings (see page 106).
- Change the method in which you receive notifications (see page 107).
- Download software (see page 110).

Manage Your Personal Information

Use the personal information page in account settings to do the following:

- Update your contact and password information
- Reset your home page
- Set the current timesheet as your home page

See the Resource Management User Guide for more information.
Manage Your Personal Information

Follow these steps:

1. Open Home, and from Personal, click Account Settings.
   The personal information page appears.

2. In the General Information section, complete the following fields, and save:
   
   **User Name**
   
   Defines the user name that the resource uses to log in to CA Clarity PPM. On the personal information page, displays the user name.

   **Limits:** 80 characters

   **Last Name**
   
   Defines the last name for the resource. On the personal information page, displays the last name.

   **Required:** Yes

   **First Name**
   
   Defines the first name for the resource.

   **Required:** Yes

   **Email Address**
   
   Defines the address the notifications and other CA Clarity PPM communications are sent to. On the personal information page, displays the email address.

   **Required:** Yes

   **Note:** Accurate and updated address is required.

   **SMS Address**
   
   Defines the SMS (Short Messaging Service) address to which notifications are sent. The SMS transmits short messages to mobile communications devices such as cellular telephones.

   **Note:** Contact your mobile service provider for details about using the SMS.

   **Work Phone**
   
   Defines your work telephone number.

   **Home Phone**
   
   Defines your home telephone number.

   **Time Zone**
   
   Defines the primary workplace time zone.
Locale
Defines your work locale. The locale drives the number and date language formatting in CA Clarity PPM.

Default: English (United States)

Language
Defines the language to use CA Clarity PPM. The language selected here also applies to the Business Objects reports for the resource.

Note: Change in the language takes 15 minutes to reflect. You can wait for 15 minutes, or log out and log back in to reflect the change.

Default: English

Home Page
Defines your home page.

Default: System Default or User Configured

Update Your Password

You can include an unlimited number of characters in your password.

Best Practice: Select a combination of letters and numbers in your password to help ensure that your information remains secure.

Follow these steps:
1. Open Home, and from Personal, click Account Settings.
The personal information page appears.
2. In the Change Passwords section, complete the following fields, and save:
   Old Password
   Defines the current password you use to log in to CA Clarity PPM.
   New Password
   Defines the new password you can use to log in to CA Clarity PPM.
   Confirm Password
   Defines the confirmation of the new password you can use to log in to CA Clarity PPM.
Designate Proxies

You can temporarily designate another resource as your action items proxy using the proxy page in account settings. As a proxy, the assigned resource receives action items (such as your regularly scheduled or urgent actions items) during the specified proxy period.

During the period that an action item is due, the designated proxy sees the action item in their Action Items portlet on their overview page.

Important! Verify that the resource designated as your action items proxy has the appropriate access rights for the actions they must process. For example, if you designate a proxy to receive action items to approve timesheets, the proxy requires the Timesheets - Approve All right.

Follow these steps:
1. Open Home, and from Personal, click Account Settings.
2. Click Proxy.
   The proxy page appears.
3. In the Setup section, complete the following, and save:
   Proxy
   Specifies if you want to use a proxy.

   Resource
   Defines the resource being designated as your proxy.

   Start Date
   Defines the start date for the proxy period.

   End Date
   Defines the end date for the proxy period.

View Your List of Proxies

If other resources have designated you as their action items proxy, their names appear in the Resources field on the proxy page of account settings. Any action items that become due during the proxy period display in your Action Items portlet on the overview page. One or more resources can designate you as a proxy.
Notifications Setup

Notifications are automatically generated when certain actions are triggered. For example, you can select notification by email when someone responds to an action item.

You can view and manage the method in which you receive your notifications when their associated events are triggered. Select from the following types of notification methods:

- **Alert.** Sends alerts to the Notifications portlet on the overview page and to the notifications page of the organizer.
- **Email.** Sends emails to your email account. Specify your email address in your resource profile to use this notification method.
- **SMS.** Transmits short messages to mobile communications devices such as cellular telephones.

**Note:** Specify your Short Message Service (SMS) address to use this notification method.

Notification Functional Areas

The following list describes examples of situations that trigger notifications for each functional area:

**Action Items**

A notification is sent out when a new action item is assigned to you and when one is due.

**Change Request**

A notification is sent when you are assigned to a change request.

**Escalation**

A notification is sent when a process fails or stalls and you are identified as the person to notify for escalations.

**Issues**

A notification is sent when you are assigned to an issue.

**Processes**

A notification is sent when a resource identifies you as the person to contact for a certain step in a process.

**Projects**

A notification is sent when a resource adds you to or removes you from a project.
Reports and Jobs
A notification is sent when a report or job you initiated, scheduled, or assigned to is completed or failed.

Risks
A notification is sent when you are assigned to a risk.

Timesheets
A notification is sent when you receive notification for a timesheet submitted. If you submitted a timesheet, you can receive notification that it is overdue or returned.

Manage Your Notification Settings
Use the notifications page in account settings to specify, or change the types of notifications you want to receive. You can also specify the method used to receive notifications.

All the method check boxes for each functional area are selected by default.

Follow these steps:
1. Open Home, and from Personal, click Account Settings.
   The personal information page appears.
2. Click Notifications.
   The notifications page appears.
3. Select the check box next to each notification and method you want to receive, and save the changes.

Specify Notification Methods
You can view and manage the method in which you receive your notifications when their associated events are triggered. Select from the following types of notification methods:

- Alert. Sends alerts to the Notifications portlet on the overview page and to the notifications page of the Organizer.
- Email. Sends emails to your email account.
  Specify your email address in your resource profile to use this notification method.
  See the Resource Management User Guide for more information.
SMS. Transmits short messages to mobile communications devices such as cellular telephones.

Specify your Short Message Service (SMS) address to use this notification method.

Follow these steps:
1. Open Home, and from Personal, click Account Settings.
   The personal information page appears.
2. Click Notifications.
   The notifications page appears.
3. Clear the check box next to each notification and method you do not want to receive, and save the changes.

Software Downloads

You can download the following software from CA Clarity PPM:

Open Workbench

This application is desktop project management software. You can use Open Workbench as a stand-alone software application or with CA Clarity PPM.

Microsoft Project Interface

Use CA Clarity PPM Microsoft Project Interface to connect Microsoft Project with CA Clarity PPM.

Java Runtime Environment

Use Java Runtime Environment to use XML Open Gateway (XOG) to pass data between CA Clarity PPM and other programs.

Adobe SVG Viewer

Allows you to view graphical portlets and processes.

SAP BusinessObjects Xcelsius 2008

Used to download and install the Xcelsius locally on your computer. Use Xcelsius to create visualizations and to set up the data connections.

Note: For this download link to display on the software downloads page, requires access rights to install Xcelsius. In addition, the CA Clarity PPM administrator requires copying the Xcelsius setup zip file to a CA Clarity PPM install folder.

Contact your CA Clarity PPM administrator if you are unable to download Xcelsius.
CA Clarity UI Themes as Xcelsius Color Schemes

Used to give your Xcelsius visualizations the same colors as your portlets and pages in CA Clarity PPM. The CA Clarity PPM UI themes are available to use in Xcelsius visualizations.

Follow the instructions on the software downloads page for information about making UI themes available as Xcelsius color schemes.

Design Files for Stock Xcelsius Visualizations

Used to help you get started with sample implementations. You can use the Xcelsius visualizations design files (.XLF) as is, or you can use them as a starting point to design your own Xcelsius visualizations.

See the CA Clarity-Xcelsius Implementation Guide for more information.

Download Software

Use the following procedure to download client software to your computer from CA Clarity PPM. To download software:

- The CA Clarity PPM administrator requires setting up the installation files on the CA Clarity PPM server.
- Requires the access rights to download the software.
- Requires administrator rights to install the software.

**Note:** Even if you have the appropriate access rights, the software may not be available. Make a note of the folder location to which you install the software.

See your CA Clarity PPM administrator for assistance if you are unable to download the required client software. In addition, contact your administrator if you have questions about the download process.

**Follow these steps:**

1. Open Home, and from Personal, click Account Settings.
   
   The personal information page appears.

2. Click Software Downloads.
   
   The software downloads page appears.

3. Click the Download link next to the name of the software.
   
   Depending on the software you select, a series of file download, "Save As", and install windows open.

4. Follow the download instructions.
Appendix A: Keyboard Shortcuts

This section contains the following topics:
Keyboard Shortcuts for Basic Features (see page 111)
Keyboard Shortcuts for CA Clarity PPM Actions (see page 111)
Keyboard Shortcuts for Lists (see page 112)

Keyboard Shortcuts for Basic Features

The following table shows the keyboard shortcuts for basic features available on all CA Clarity PPM pages.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Menu</td>
<td>Ctrl+Alt+h</td>
</tr>
<tr>
<td>Administration Menu</td>
<td>Ctrl+Alt+a</td>
</tr>
<tr>
<td>Favorites Menu</td>
<td>Ctrl+Alt+f</td>
</tr>
<tr>
<td>Back</td>
<td>Ctrl+Alt+b or Alt+Left Arrow</td>
</tr>
<tr>
<td>Home Page</td>
<td>Ctrl+Alt+Home</td>
</tr>
<tr>
<td>Refresh</td>
<td>Ctrl+Alt+F5</td>
</tr>
<tr>
<td>Search</td>
<td>Ctrl+Alt+s</td>
</tr>
<tr>
<td>History</td>
<td>Ctrl+Alt+v</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts for CA Clarity PPM Actions

The following table shows keyboard shortcuts for actions on CA Clarity PPM pages.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key Combination</th>
<th>Alternate Accessibility Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate a field editor (for example, a date picker)</td>
<td>Enter</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>Close a popup</td>
<td>Esc</td>
<td>Shift+Esc</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts for Lists

The following table shows the keyboard shortcuts for lists.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key Combination</th>
<th>Alternate Accessibility Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open a tab menu</strong></td>
<td>Enter</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td><strong>Move left, right, up, or down in a menu</strong></td>
<td>Left Arrow, Right Arrow, Up Arrow, Down Arrow</td>
<td>Alt+Up Arrow, Alt+Down Arrow, Alt+Up Arrow, Alt+Down Arrow</td>
</tr>
<tr>
<td><strong>Select a highlighted menu item</strong></td>
<td>Enter</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td><strong>Open a link in a list page</strong></td>
<td>Ctrl+Enter</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td><strong>Select or clear a check box</strong></td>
<td>Space Bar</td>
<td></td>
</tr>
<tr>
<td><strong>Expand a hierarchical list</strong></td>
<td>Space Bar</td>
<td></td>
</tr>
</tbody>
</table>

---

**Note:**
- Focus must be on the checkbox.
- Focus must be on the + in the hierarchical list.

---

### Keyboard Shortcuts for Lists

<table>
<thead>
<tr>
<th>Action</th>
<th>Mode</th>
<th>Keyboard Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switch between edit and display mode in a list</strong></td>
<td>Display, Edit</td>
<td>Enter</td>
</tr>
<tr>
<td><strong>Move from cell to cell through a list (grid)</strong></td>
<td>Display</td>
<td>Left Arrow, Right Arrow, Up Arrow, Down Arrow</td>
</tr>
<tr>
<td><strong>Move to different areas within a list: portlet icons, column headers, body of list, buttons</strong></td>
<td>Display</td>
<td>Tab (Forward), Shift+Tab (Back)</td>
</tr>
<tr>
<td><strong>Switch to display mode</strong></td>
<td>Edit</td>
<td>Esc or Enter</td>
</tr>
<tr>
<td><strong>Move left or right within a cell</strong></td>
<td>Edit</td>
<td>Left Arrow, Right Arrow</td>
</tr>
<tr>
<td><strong>Move from editable cell to editable cell</strong></td>
<td>Edit</td>
<td>Tab (Forward), Shift+Tab (Back)</td>
</tr>
<tr>
<td>Action</td>
<td>Mode</td>
<td>Keyboard Combination</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Open a drop-down list or a date selector</td>
<td>Edit</td>
<td>Enter</td>
</tr>
<tr>
<td>Move through selection items in a drop-down</td>
<td>Edit</td>
<td>Up Arrow Down Arrow</td>
</tr>
<tr>
<td>Select a highlighted value in a drop-down or a date selector</td>
<td>Edit</td>
<td>Enter</td>
</tr>
<tr>
<td>Highlight a date in a date selector</td>
<td>Edit</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Add a new line in a long text area</td>
<td>Edit</td>
<td>Ctrl+Enter</td>
</tr>
</tbody>
</table>
Appendix B: Crystal Reports Stock Report Descriptions

Stock reports are included with CA Clarity PPM. This section lists the reports with descriptions, the requirements to run the report, and the parameters to filter the data.

This section contains the following topics:
- **Budget Forecast Analysis Report** (see page 115)
- **Chargeback GL Account Activity Report** (see page 119)
- **Customer & Provider Chargeback Report** (see page 121)
- **Key Tasks and Milestone Status Report** (see page 124)
- **Missing Time Report** (see page 127)
- **Portfolio Alignment Report** (see page 129)
- **Investment Status Report** (see page 133)
- **Project Transactions Inquiry Report** (see page 138)
- **Resource Assignments Report** (see page 144)
- **Resource by Role Description Report** (see page 147)
- **Timesheet Detail Report** (see page 149)

### Budget Forecast Analysis Report

**Description**

This report provides an analysis of budget, actual, and forecast costs by investment manager. Amounts display in the currency that is set in the report parameter. For projects with a detailed budget, the forecast feature is used to determine Estimate at Complete (EAC) based on the following: (Actuals Posted + Remaining Forecast). Otherwise, a prorated simple budget is used to determine the remaining forecast.

This report can be run only from CA Clarity PPM and not from BusinessObjects InfoView.

The graph shows the percentage of budget at completion by investment manager.

Run the report to work with the following:

- Project management.

  See the *Project Management User Guide* for more information.

- Financial management.

  See the *Financial Management User Guide* for more information.
Budget Forecast Analysis Report

- Service management.
  See the *IT Service Management User Guide* for more information.
- Demand management.
  See the *Demand Management User Guide* for more information.
- Portfolio management.
  See the *Portfolio Management User Guide* for more information.

**Prerequisites**

- The project requires enabling financially to generate the report.
  See the *Project Management User Guide* for more information.
- A simple budget, a forecast, or a detailed budget required for data to display on the report.
- For actual costs to display, enter and post transactions through financial processing.
- For Estimate at Complete (EAC) data to display, projects must be scheduled. In addition, cost rates must be set up in a cost/rate matrix with the matrix assigned to the projects.
- To use the OBS Unit parameter to filter the report, require at least one OBS in the system. In addition, require an OBS unit assigned to the programs or projects.
- Exchange Rate (Type=Average) must exist to do the calculation from investment to reporting currency.

**Parameters**

**Investment Approval**
Indicates the status of the investments in the report. Select the appropriate status from the drop-down.

**Investment Manager**
Identifies the investment manager whose data displays in the report. Click the Browse icon to select the investment manager name.

**OBS Unit**
Indicates the OBS unit by which the report is filtered.

**Reporting Currency**
Defines the currency type that appears on the report for amounts and totals.
Start Date

Defines the start date of the report. To select a specific day, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date such as Start of Next Month, select the Relative Date option. Then, select the relative date from the drop-down list.

Report Fields

% Spent

Displays the percentage of the actual budget spent to date.

Calculation: (Actual to Date /Budget Total) x 100

Database Tables and Columns:

A calculated field. For more information, see the report SQL statement.

% Total Budget

Displays the amount spent as opposed to the amount budgeted.

Calculation: (EAC / Budget Total) x 100

Database Tables and Columns:

A calculated field. For more information, see the report SQL statement.

Actual to Date

Displays the actual amount of the budget spent to date. The data is taken from the aggregated actuals posted in WIP.

Database Tables and Columns:

ppa_wip_values.total_cost

Budget Total

Displays the total amount of the budget for the investment.

Database Tables and Columns:

If the investment has a detail budget, this value is taken from fin_financials.budget_cst_total, else it is taken from fin_financials.planned_cst_total.

EAC

Displays the estimated actuals at completion.

Calculation: Actual to Date + Month (1 through 3) + Remainder

Database Tables and Columns:

A calculated field. For more information, see the report SQL statement.
Forecast (Months 1-3)

Displays the budget forecast for selected months (1-3). The Forecast fields require a detail or a simple budget for the investment for data to appear in these fields.

If a detail budget exists, the forecast plan of record is used for the parameter Start Date and the totals posted in the fields.

If only a simple budget exists, the single budget amount is evenly distributed over the duration of the project. For example: If the simple budget=12,000 and the project duration is six months, the monthly budget/forecast is 2,000.

Database Tables and Columns:

If the investment has a detailed budget, this value is taken from the slice table odf_ssl_cst_dtl_cost.slice.

If the investment has simple budget and has forecast cost, the report does its slicing during the runtime based on the forecast cost. If the forecast cost is not present, the same calculation is done based on the planned cost.

Manager

Displays the name of the manager whose projects are being reported.

Database Tables and Columns:

nbi_project_current_facts.manager_last_name
nbi_project_current_facts.manager_first_name

Plan/Budget Variance

Displays the difference between the actuals budgeted and the actuals posted at completion.

Calculation: Budget Total - EAC

Database Tables and Columns:

A calculated field. For more information, see the report SQL statement.

Project

Displays the project being reported on.

Database Tables and Columns:

nbi_project_current_facts.project_name

Remainder

Displays the remaining months where actuals are not posted.

Database Tables and Columns:

The same as Forecast (Months 1-3), but it includes the slice values remaining after month 3.
Chargeback GL Account Activity Report

Description

The GL-centric report provides a summary that shows debits and credits for a GL period. Below the summary-level presentation, a detailed presentation shows transactions. This report is used for auditing. The report provides different layouts, depending on the option selected for the Group-By parameter (Investment or Resource).

The report includes information about the following: Active and inactive investments, all investment types, approved and unapproved investments (if transactions exist).

Prerequisites

- The investment requires enabling financially.
  See the Project Management User Guide for more information.
- Transactions required for the investment.
- Invoices require approvals to show on the Credit to Allocation.
- GL-Period End and GL-Period Start require belonging to the same entity and same period type. For example, monthly.

Parameters

GL-Period End
Indicates the end of the reporting period. Click the Browse icon and select a date from the list that appears.

GL-Period Start
Indicates the start of the reporting period. Click the Browse icon and select a start time from the list that appears.

Group By
Indicates the grouping and presenting of information on the report. Select an option from the drop-down.

Investment
Indicates the name of the investment to generate data in the report. Click the Browse icon and select the investment from the list that appears.

Resource
Indicates the name of the resources to generate data in the report. Click the Browse icon and select names from the list that appears.
Report Fields

**Account**
Displays the account identifier.

**Database Tables and Columns:**
cbk_gl_account.main_account_id
cbk_gl_account.sub_account_id

**Account Description**
Displays in text what the corresponding account number represents.

**Database Tables and Columns:**
cbk_gl_account.sub_account_id

**Charge to Allocation**
Displays the share (or allocation) to be charged to a customer. The share is based on the transaction amount and the debit-rule, splitting the total transaction cost between accounts.

**Database Tables and Columns:**
If cbk_gl_txns.chargeback_type = "" THEN cbk_scaled_gl_txns.scaled_amount

**Credit to Allocation**
Displays the share of transactions of approved invoices to credit to a provider. Total cost is split between provider accounts according to credit rules.

**Database Tables and Columns:**
If cbk_gl_txns.chargeback_type = "" THEN cbk_scaled_gl_txns.scaled_amount

**GL-Period**
Displays the GL time period for generating the report in the yyyy/mm format.

**Database Tables and Columns:**
biz_com_periods.period_name

**Investment**
Displays the name of the investment to generate the report.

**Database Tables and Columns:**
prteam.prprojectid
Resource
Displays the resource associated with charges at the detailed level in the report.

Database Tables and Columns:
srm_resources.last_name
srm_resources.first_name

Task
Displays a project task being reported.

Database Tables and Columns:
prtask.prname

Transaction Date
Displays the transaction date in the mm/dd/yyyy format.

Database Tables and Columns:
cbk_scaled_gl_txns.transaction_date

Customer & Provider Chargeback Report

Description
The report displays financial customer and provider portfolio status and chargeback information. By design, the report displays only one entity information at a time. The report does not support displaying investments from multiple entities. GL periods are required field parameters, and they are tied to a specific entity. Therefore, only that entity details are displayed. If GL period start is from one entity and GL period end is from another entity, the report displays no results.

Prerequisites
■ Chargeback data for the investment required for the investment and its actuals to show on a report.
■ A budget or planned cost required to display budget or planned cost data.
■ An All-* debit rule required for the investment or systemwide to show a pro-rated budget for the customer.
■ The All-* rule required to calculate budget/planned cost and forecast costs split across departments. If a department has actual charges but is not defined in the All-* rule, the department does not appear in the report.
■ If the budget/planned cost/forecast start date does not have an allocation in the All-* rule, the investment does not display in the report.
Every investment requires the following dates with a corresponding allocation in the All-* rule:
- Planned dates
- Budget dates
- Forecast dates
If not, the investment does not display in the report.

An entity defined and the project enabled financially.

**Parameters**

**Customer**
Indicates the department charged with the investment cost according to the debit rule allocation. Click the Browse icon and select a name from the list that appears.

**GL-Period End**
Indicates the end of the reporting period. Click the Browse icon and select a date from the list that appears.

**GL-Period Start**
Indicates the start of the reporting period. Click the Browse icon and select a start time from the list that appears.

**Group By**
Indicates the grouping and presenting of information on the report. Select an option from the drop-down.

**Plan Type**
Indicates the plan type to filter the report. Select the plan type from the drop-down list in the field.

**Provider**
Indicates the department providing the service. Click the Browse icon and select a name from the list that appears.

**Report Fields**

**Budget**
Displays the prorated budget/planned cost for a specific customer based on the total investment budget split using the All-* debit rule.

**Database Tables and Columns:**
fin_financials.budget_cst_total* odf_ssl_gl_all_dtl_pct.slice
Customer
Displays the department receiving and paying for a service.

**Database Tables and Columns:**
departments.description

Entity
Displays the entity the investment belongs to.

**Database Tables and Columns:**
entity.entity

**Forecast-to-Date (FTD)**
Displays the prorated forecast (Actuals + Remaining Planned Cost) as of the current date, based on the total investment forecast split using the All-* debit rule.

**Database Tables and Columns:**
fin_financials.forecast_cst_total* odf_ssl_gl_al_dt_pct.slice

GL-Period
Displays the GL time period for generating the report in the yyyy/mm format.

**Database Tables and Columns:**
biz_com_periods.period_name

**Inception-to-Date (ITD)**
Displays all actuals charged to a customer from the investment start date to the current date.

**Database Tables and Columns:**
cbk_scaled_gl_txns.scaled_amount

Investment
Displays the name of the investment to generate the report.

**Database Tables and Columns:**
prteam.prprojectid

**Period-to-Date (PTD)**
Displays the actuals charged to a customer from the investment start period to the current date.

**Database Tables and Columns:**
cbk_scaled_gl_txns.scaled_amount
Planned Cost
Displays the plan of record for the investment pro-rated using the All-* rule.

**Database Tables and Columns:**
fin_financials.planned_cst_total* odf_ssl_gl_all_dtl_pct.slice

Provider
Displays the department responsible for the investment.

**Database Tables and Columns:**
departments.description

Year-to-Date (YTD)
Displays the actuals charged to a customer from the beginning of the year to the current date.

**Database Tables and Columns:**
ckk_scaled_gl_txns.scaled_amount

---

### Key Tasks and Milestone Status Report

#### Description
This report provides a status and variance for project key tasks, milestones, phases, or the full work breakdown structure. The pie chart compares late and on time task starts and finishes.

Run the report to work with project management.

**Note:** See the *Project Management User Guide* for more information.

#### Requirements
- At least one key task or milestone requires creating on the project.
- If you enter the appropriate data into the project schedule, data displays for each WBS type, as selected in the parameters.
- To filter using the OBS Unit parameter, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.

#### Parameters
**Include Completed Tasks**
Indicates to include completed tasks in report data.

**Default:** Cleared
Group By
Indicates the grouping and presenting of information on the report. Select an option from the drop-down.

OBS Unit
Indicates the OBS unit by which the report is filtered.

Print Late Items Only
Indicates to include items identified as late in report data.
Default: Cleared

Project
Indicates the projects to generate the report.

Threshold
Indicates the number of days that pass before a project shows a yellow or red stoplight status.

WBS Type
Indicates the level of WBS data to display on the report. Select the option from the drop-down list.

Charts
Two pie charts indicate the number of late starts and finishes compared to on-time starts and finishes.

Report Fields

% Complete
Displays the portion of the task, milestone, or phase completed. This field is a not calculated, but is shown as the user specifies.

Database Tables and Columns:
prtask.prptctcomplete

Finish Date
Displays the finish date for the task.

Database Tables and Columns:
prtask.prfinish
Finish Variance
Displays any difference between the planned finish date and the actual finish date, or the date of the report.

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

Performance
Displays through stoplights the performance for the task, milestone, or phase according to the threshold set.

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

Start Date
Displays the start date for the task, phase, or milestone.

**Database Tables and Columns:**
prtask.prstart

Start Variance
Displays the difference between the planned start date and the actual start date, or the date of the report.

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

Task
Displays a project task being reported.

**Database Tables and Columns:**
prtask.prname

Task Status
Displays if a task, milestone, or phase is started, not started, or complete.

**Database Tables and Columns:**
prtask.prstatus

Type
Displays if the report item is a task, milestone, or a phase.

**Database Tables and Columns:**
prtask.pristask, prtask.priskey, prtask prismilestone
**Missing Time Report**

**Description**

This report lists all resources who have submitted less time than the available hours on their calendar during a specified time period. Also, reports the resources not provided timesheet hours.

Run the report to work with resource management.

**Note:** See the *Resource Management User Guide* for more information.

**Prerequisites**

- Resources assigned a calendar.
- To use the OBS Unit parameter to filter, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.

**Parameters**

**Group By**

Indicates the grouping and presenting of information on the report. Select an option from the drop-down.

**OBS Unit**

Indicates the OBS unit by which the report is filtered.

**Resource Manager**

Identifies the resource managers whose data displays in the report. Click the Browse icon to select names.

**Resource Type**

Indicates the category of resource to generate the report. You can select multiple categories.

**Status**

Indicates the status of resource timesheets to include on the report. You can select multiple statuses.

**Time Period**

 Defines the time period date range to filter the report. To define a Specific Date, click the Select Date icon, or a Time Period relative to the current date from the drop-down.

If you enter a date as a parameter, the application scans all the time periods to find and assign the time period accordingly.
Charts

Two pie charts indicate the following:

- The number of resources that completed time entry, had partial entry, or had no time entry.
- The actual hours entered compared against the missing hours.

Report Fields

Actual

Displays the number of hours the resource charged during the reporting time period.

**Database Tables and Columns:**

`prtimeentry.practsum`

Available

Displays the number of chargeable hours available for the resource during the reporting time period.

**Database Tables and Columns:**

`nbi_resource_facts.available_hours`

Email

Displays the email address of the resource.

**Database Tables and Columns:**

`srm_resources.email`

Missing

Displays the number of missing (uncharged) hours for the resource.

Calculation: Available - Actual

**Database Tables and Columns:**

A calculated field. For more information, see the report SQL statement.

Resource ID

Displays the unique identifier for the resource.

**Database Tables and Columns:**

`srm_resources.id`

Resource Name

Displays the resource being reported.

**Database Tables and Columns:**

`nbi_resource_facts.full_name`
Status
Displays the status of the timesheet for the reporting time period.

**Database Tables and Columns:**
prtimesheet.prstatus

Time Period
Displays the reporting time period with missed time for the resource. It indicates the start and end dates of the time period.

**Database Tables and Columns:**
prtimeperiod.prstart
prtimeperiod.prfinish - 1

**Portfolio Alignment Report**

This report indicates how a portfolio of projects is aligned to company priorities based on a consistent project scoring mechanism. The report contains graphics that displays:

- The distribution of total investment an organization has already made and currently scheduled
- How the resources of an organization scheduled to spend time based on the goal alignment scores.

**Requirements**

- Projects, services, or other investment types exist in CA Clarity PPM.
- If you are using the project goals and alignment activity features, displays the project scoring data and graphics.

See the *Project Management User Guide* for more information.

**Parameters**

**End Date**
Defines the end date of the report. To select a specific end date, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date, select the Relative Date option and the relevant relative date from the drop-down list.

**Investment Type**
Indicates the project of the investment type to include in the report. Click the Browse icon and select the investment type from the list.
Manager
Indicates the manager whose projects are included in the report.

OBS Unit
Indicates the OBS unit by which the report is filtered.

Plan Type
Indicates the plan type to filter the report. Select the plan type from the drop-down list in the field.

Project Approval
Indicates the approval status of the projects to include in the report.

Reporting Currency
Indicates the currency of the financial information.

Start Date
Defines the start date of the report. To select a specific day, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date such as Start of Next Month, select the Relative Date option. Then, select the relative date from the drop-down list.

Charts
- Alignment by Budget shows the distribution of projects according to cost (bubble size), risk (color), alignment (horizontal axis), and goal (vertical axis).
- Alignment by Effort shows the distribution of projects according to effort (bubble size), risk (color), alignment (horizontal axis) and goal (vertical axis).

Report Fields

Actual Hours
Displays the number of hours charged to the project for the time period selected.

Database Tables and Columns:
\text{nbi\_project\_current\_facts.\_actual\_hours}

Alignment Score
Displays how well an investment is aligned to the business goal. This value displays in the form of a stoplight symbol (red, yellow, or green). The stoplight is a range defined as red (0–33), yellow (34–67) and green (68–100). Alignment score of 100 indicates the investment is in perfect alignment with the organization business goal. This value is assigned and can be changed on the properties page for an investment.

Database Tables and Columns:
\text{nbi\_project\_current\_facts.\_goal\_score}
Budget Cost
Displays the budgeted cost for a project or any other investment. The budget cost is based on the budget cost plan. If no detailed budget exists, the budget cost is taken from planned cost.

Database Tables and Columns:
nbi_project_forecast.cost_budget_total

Budget Hours
Displays the number of hours budgeted for the project.

Database Tables and Columns:
nbi_project_current_facts.budget_hours

Cost Variance
Displays the difference between the budgeted cost and the estimate at complete (EAC) cost.
Calculation: Budgeted Cost - Estimated Cost at Completion

Database Tables and Columns:
(nbi_project_forecast.cost_budget_total) –
(nbi_project_current_facts.cost_act_total +
nbi_project_current_facts.cost_etc_total)

EAC Cost
Displays the estimate at completion (EAC) in cost.
Calculation: ETC Total Cost + Total Actual Cost

Database Tables and Columns:
A calculated field. For more information, see the report SQL statement.

EAC Hours
Displays the estimate at completion (EAC) in hours.
Calculation: Estimate to Complete (ETC) Hours + Actual Hours

Database Tables and Columns:
A calculated field. For more information, see the report SQL statement.

Forecast Cost
Displays the forecast cost for a project or any other investment. Forecast is based on the plan or record (POR) cost plan. If no POR exists, forecast is equal to planned cost.

Database Tables and Columns:
fin_financials.forecast_cst_total
Hours Variance
Displays the difference between the hours budgeted for a project and the hours that are estimated at completion.
Calculation: Budgeted Hours - Estimate at Completion Hours

Database Tables and Columns:
A calculated field. For more information, see the report SQL statement.

Manager
Displays the name of the manager whose projects are being reported.

Database Tables and Columns:
nbi_project_current_facts.manager_last_name
nbi_project_current_facts.manager_first_name

Project
Displays the project being reported on.

Database Tables and Columns:
nbi_project_current_facts.project_name

Risk
Displays using stoplights if a project is at risk. Mouseover a stoplight to see a tooltip about the stoplight.

Database Tables and Columns:
If the Investment type is “Project” then
(inv_projects.rcf_flexibility * 1.0 +
inv_projects.rcf_funding * 1.0 +
inv_projects.rcf_human_interface * 1.0 +
inv_projects.rcf_implementation * 1.0 +
inv_projects.rcf_interdependency * 1.0 +
inv_projects.rcf_objectives * 1.0 +
inv_projects.rcf_org_culture * 1.0 +
inv_projects.rcf_resource_avail * 1.0 +
inv_projects.rcf_sponsorship * 1.0 +
inv_projects.rcf_supportability * 1.0 +
inv_projects.rcf_technical * 1.0) / (11.0)
For other investment types, the value is taken from inv_investment.risk.
Investment Status Report

This report produces a listing of investments and key investment attributes. You can run this report to view a list all active investments associated with a specific resource manager.

Run this report to work with the following:

- Application Management
- Asset Management
- Demand Management
  See the Demand Management User Guide for more information.
- Project management
  See the Project Management User Guide for more information.
- Resources
  See the Resource Management User Guide for more information.
- Service Management
  See the IT Service Management User Guide for more information.

Requirements

- Investments required in CA Clarity PPM.
- To use the OBS Unit parameter to filter the report, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.

Parameters

Project Approval
Indicates the approval status of the projects to include in the report.

Project Name
Indicates the project or projects to include in the report. Click the Browse icon and select the projects from the list.

Project Manager
Indicates the managers whose projects require reporting.

Status
Indicates the status of resource timesheets to include on the report. You can select multiple statuses.

Reporting Currency
Defines the currency type that appears on the report for amounts and totals.
Investment Type

Indicates the project of the investment type to include in the report. Click the Browse icon and select the investment type from the list.

Report Fields

Actual Hours

Displays the number of hours charged to the project for the time period selected.

Database Tables and Columns:
nbi_project_current_facts.actual_hours

Budget Cost

Displays the budgeted cost for a project or any other investment. The budget cost is based on the budget cost plan. If no detailed budget exists, the budget cost is taken from planned cost.

Database Tables and Columns:
nbi_project_forecast.cost_budget_total

Budget Hours

Displays the number of hours budgeted for the project.

Database Tables and Columns:
nbi_project_current_facts.budget_hours

Changes

Displays the level of changes for a project using stoplights. See the legend in the report for stoplight values.

Database Tables and Columns:
Maximum of odf_change_v2.priority_code

Cost Variance

Displays the difference between the budgeted cost and the estimate at complete (EAC) cost.

Calculation: Budgeted Cost - Estimated Cost at Completion

Database Tables and Columns:
(nbi_project_forecast.cost_budget_total) –
(nbi_project_current_facts.cost_act_total +
nbi_project_current_facts.cost_etc_total)
Currency Code
Displays the currency for the project totals.

**Database Tables and Columns:**
nbi_project_current_facts.currency_code

EAC Cost
Displays the estimate at completion (EAC) in cost.
Calculation: ETC Total Cost + Total Actual Cost

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

EAC Hours
Displays the estimate at completion (EAC) in hours.
Calculation: Estimate to Complete (ETC) Hours + Actual Hours

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

Finish Date
Displays the finish date for the task.

**Database Tables and Columns:**
prtask.prfinish

Finish Variance
Displays any difference between the planned finish date and the actual finish date, or the date of the report.

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

Hours Variance
Displays the difference between the hours budgeted for a project and the hours that are estimated at completion.
Calculation: Budgeted Hours - Estimate at Completion Hours

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.
Issues
Displays the level of open issues for a project using stoplights. See the legend on the report for stoplight values.

**Database Tables and Columns:**
Maximum of odf_issue_v2.priority_code

OBS
Displays the organizational breakdown structure for the projects on the report.

**Database Tables and Columns:**
nbi_dim_obs.obs_unit_id

Progress
Displays using a progress bar how complete the project is.

**Database Tables and Columns:**
odf_inv_v.stage
odf_inv_v.stage_number

Project Manager
Displays the name of the manager whose projects are being compared against set goals.

**Database Tables and Columns:**
nbi_project_current_facts.manager_last_name
nbi_project_current_facts.manager_first_name

Project Name
Displays the name of project to generate a report.

**Database Tables and Columns:**
nbi_project_current_facts.project_name
Risk

Displays using stoplights if a project is at risk. Mouseover a stoplight to see a tooltip about the stoplight.

**Database Tables and Columns:**

If the Investment type is “Project” then

\[
\frac{\text{inv} \_\text{projects}.\text{rcf} \_\text{flexibility} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{funding} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{human} \_\text{interface} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{implementation} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{interdependency} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{objectives} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{org} \_\text{culture} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{resource} \_\text{avail} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{sponsorship} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{supportability} \times 1.0 + \text{inv} \_\text{projects}.\text{rcf} \_\text{technical} \times 1.0}{11.0}
\]

For other investment types, the value is taken from inv.investment.risk.

S1

Displays the overall health of the project using a stoplight. See the legend on the report for stoplight values.

**Database Tables and Columns:**

Based on budget flags (S2 and S3).

S2

Displays the hour variance of a project using stoplights. See the legend on the report for stoplight values.

**Database Tables and Columns:**

Based on Hours Variance.

S3

Displays the cost variance between the budgeted cost and the EAC cost using a spotlight. See the legend on the report for stoplight values.

**Database Tables and Columns:**

Based on Cost Variance.
**Project Transactions Inquiry Report**

**Description**

This report provides a list of the detailed posted or unposted financial transactions for a project over a specified date range. For example, you can view the following:

- All the financial transactions for all projects managed by "Kate Jones" in the last six months.
- All the financial transactions for the "Online Bill Presentment" project from inception to date.

This report can be run only from CA Clarity PPM and not from BusinessObjects InfoView.

Run this report to work with the following:

- Project management to analyze WIP
- Financial management
- Service management
- Demand management
Portfolio management

Requirements

- Enable financially the project to generate the report.
  
  **Note**: See the Project Management User Guide for more information.

- Transactions require entering and posting through financial processing.

- To use the OBS Unit parameter to filter the report, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.
Parameters

**End Date**
Defines the end date of the report. To select a specific end date, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date, select the Relative Date option and the relevant relative date from the drop-down list.

**OBS Unit**
Indicates the OBS unit by which the report is filtered.

**Project Manager**
Indicates the managers whose projects require reporting.

**Project**
Indicates the projects to generate the report.

**Start Date**
Defines the start date of the report. To select a specific day, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date such as Start of Next Month, select the Relative Date option. Then, select the relative date from the drop-down list.

**Transaction Status**
Indicates the transactions included in the report are active or inactive.

Report Fields

**Amount Billed**
Displays the total amount billed to the project.

*Database Tables and Columns:*
  nbi_project_current_facts.act_billing

**Approved By**
Displays the project approver.

*Database Tables and Columns:*
  pac_mnt_projects.resourcecode

**Approved Date**
Displays when the project was approved.

*Database Tables and Columns:*
  pac_mnt_projects.approveddatetime

**Bill Rate**
Displays the billing rate for the transaction.
Calculation: Quantity/Revenue

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

**Charge Code**
Displays the identification code for the transaction charge.

**Database Tables and Columns:**
ppa_wip.charge_code  
ppa_transcontrol.charge_code

**Chargeable**
Displays the chargeable hours for the project.

**Database Tables and Columns:**
ppa_wip.chargeable (= 1)  
ppa_transcontrol.chargeable (= 1)

**Company Name**
Displays the name of the company whose transactions are being reported.

**Database Tables and Columns:**
nbi_project_current_facts.customer

**Contract Amount**
Displays the amount of the contract.

**Database Tables and Columns:**
nbi_project_current_facts.contractamount

**Contract Date**
Displays the date the contract started.

**Database Tables and Columns:**
nbi_project_current_facts.contract_date

**Contract Number**
Displays the identifier of a contract associated with a project.

**Database Tables and Columns:**
nbi_project_current_facts.contract_number

**Contract Remain**
Displays the remaining amount of the contract.
Calculation: (Contract Amount - Amount Billed).
Database Tables and Columns:
A calculated field. For more information, see the report SQL statement.

**Manager**
Displays the name of the manager whose projects are being reported.

Database Tables and Columns:
nbi_project_current_facts.manager_last_name
nbi_project_current_facts.manager_first_name

**Margin**
Displays the difference between revenue and total cost of the transaction at the detail level. At the summary level, indicates the difference between the total revenue and total cost of all transactions on the report.

Calculation: Revenue - Total Cost

Database Tables and Columns:
A calculated field. For more information, see the report SQL statement.

**Non-Chargeable**
Displays the nonchargeable hours for the project.

Database Tables and Columns:
ppa_transcontrol.chargeable (<> 1)
ppa_wip.chargeable (<> 1)

**Project ID**
Displays the project identifier of the project whose transactions are included in the report.

Database Tables and Columns:
nbi_project_current_facts.project_id

**Project Status**
Displays whether the project is active or inactive.

Database Tables and Columns:
nbi_project_current_facts.fm_status

**Quantity**
Displays the number of units of labor or other items within the activity in this transaction.

Database Tables and Columns:
ppa_wip.quantity
ppa_transcontrol.quantity
Resource
Displays the resource associated with charges at the detailed level in the report.

**Database Tables and Columns:**
- srm_resources.last_name
- srm_resources.first_name

Revenue
Displays the revenue generated by the transaction.

**Database Tables and Columns:**
- ppa_transcontrol.totalamount
- ppa_wip.totalamount

Role
Displays the project role a resource performs.

**Database Tables and Columns:**
- prteam.prroleid

Total Cost
Displays the total cost of the transaction in the detail section of the report. The total cost for all transactions listed on the report is displayed in the summary section.

**Database Tables and Columns:**
- ppa_wip_values.totalcost
- ppa_transcontrol_values.totalcost

Total Hours
Displays the total hours charged for the transactions displayed on the report.

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

Total Revenue
Displays the total revenue generated for the transactions included in the report.

**Database Tables and Columns:**
- ppa_transcontrol.totalamount
- ppa_wip.totalamount

Total WIP
Displays the total work in progress for the project.

**Database Tables and Columns:**
ppa_transcontrol.totalamount
ppa_wip.totalamount

**Transaction Date**
Displays the transaction date in the mm/dd/yyyy format.

**Database Tables and Columns:**
cbk_scaled_gl_txns.transaction_date

**WIP Cleared**
Displays the amount of work in progress completed.
Calculation: (Total WIP - WIP Remain).

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

**WIP Remain**
Displays the remaining work to perform on the transaction.

**Database Tables and Columns:**
ppa_transcontrol.amountremaining
ppa_wip.amountremaining

---

**Resource Assignments Report**

**Description**
This report shows resources assigned to projects and tasks including actual hours and ETC hours.

Run the report to work with resources.

See the *Resource Management User Guide* for more information.

**Prerequisites**
- For projects, the resources require assigning to project tasks from Open Workbench or Microsoft Project to display assigned hours.
- To use the OBS Unit parameter to filter the report, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.

**Parameters**
Group By
Indicates the grouping and presenting of information on the report. Select an option from the drop-down.

Period Type
Indicates if the weekly or monthly period type requires reporting.

Project
Indicates the projects to generate the report.

Resource
Indicates the name of the resources to generate data in the report. Click the Browse icon and select names from the list that appears.

Resource Manager
Identifies the resource managers whose data displays in the report. Click the Browse icon to select names.

Resource OBS
Indicates the OBS unit to filter the report. Click the Browse icon and select the OBS from the list.

Starting Period
Defines the start date of the report. To select a specific day, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date such as Start of Next Month, select the Relative Date option. Then, select the relative date from the drop-down list.

Type of Hours
Indicates the type of hours to generate the report (allocated or assigned). You can select multiple items.

Graph
The report contains a graph that shows the assigned hours for resources on the report compared to the allocated hours for resources.

Report Fields

Actuals (h)
Displays the hours charged to the project for the time period selected.

Database Tables and Columns:
nbi_project_res_task_facts.actual_qty
Assigned (h)
Displays the assigned hours.

**Database Tables and Columns:**
A calculated field. For more information, see the report SQL statement.

**End Date**
Displays the end date for the reporting period.

**Database Tables and Columns:**
prtask.finish

**ETC Hours**
Displays the number of hours estimated to complete the task.

**Database Tables and Columns:**
nbi_project_res_task_facts.etc_qty

**Project Name**
Displays the name of project to generate a report.

**Database Tables and Columns:**
nbi_project_current_facts.project_name

**Resource Name**
Displays the resource being reported.

**Database Tables and Columns:**
nbi_resource_facts.full_name

**Start Date**
Displays the start date for the task, phase, or milestone.

**Database Tables and Columns:**
prtask.prstart

**Task Name**
Displays a project task being reported.

**Database Tables and Columns:**
prtask.prname

**Type**
Displays if the report item is a task, milestone, or a phase.

**Database Tables and Columns:**
prtask.pristask, prtask.priskey, prtask.prismilestone
Variance
Displays the percentage of difference between the hours allocated for a project and the hours assigned to resources.
Calculation: \( \frac{(\text{Assigned Hours} - \text{Allocated Hours})}{\text{Allocated Hours}} \).

Database Tables and Columns:
A calculated field. For more information, see the report SQL statement.

Resource by Role Description Report

Description
This report displays the following information:
- Capacity by role
- Resource allocation by role
- Remaining Capacity by role

Run the report to work with resources.

See the Resource Management User Guide for more information.

Prerequisites
- To use the OBS Unit parameter to filter the report, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.

Parameters

Period Type
Indicates if the weekly or monthly period type requires reporting.

Resource Manager
Identifies the resource managers whose data displays in the report. Click the Browse icon to select names.

Resource OBS
Indicates the OBS unit to filter the report. Click the Browse icon and select the OBS from the list.

Role
Indicates the roles for which the report is generated. Click the Browse icon and select roles.
Starting Period

Defines the start date of the report. To select a specific day, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date such as Start of Next Month, select the Relative Date option. Then, select the relative date from the drop-down list.

Report Fields

Alloc

Displays the percentage of the capacity hours allocated.

**Database Tables and Columns:**

prj_blb_slices.slice for request_name = dailyresourceallocacurve.

Avail

Displays the available capacity remaining.

Calculation: (Capacity Hours - Allocation Hours).

**Database Tables and Columns:**

An calculated field. For more information, see the report SQL statement.

Cap

Displays the capacity available in hours.

**Database Tables and Columns:**

prj_blb_slices.slice for request_name = dailyresourceavailcurve.

Investment

Displays the name of the investment to generate the report.

**Database Tables and Columns:**

prteam.prprojectid

Role

Displays the project role a resource performs.

**Database Tables and Columns:**

prteam.prroleid

OBS

Displays the organizational breakdown structure for the projects on the report.

**Database Tables and Columns:**

nbi_dim_obs.obs_unit_id
**Resource Name**

Displays the resource being reported.

**Database Tables and Columns:**

nbi_resource_facts.full_name

---

**Timesheet Detail Report**

This report provides a listing of the hours a resource worked for a specified period based on the timesheet. Use this report to view all hours worked during certain time periods at certain regions or locations.

Run this report to work with the following:

- Resource Management to oversee a resource time
  See the *Resource Management User Guide* for more information.
- Project management
  See the *Project Management User Guide* for more information.
- Financial management
  See the *Financial Management User Guide* for more information.
- Service management
  See the *IT Service Management User Guide* for more information.
- Demand management
  See the *Demand Management User Guide* for more information.
- Portfolio management
  See the *Portfolio Management User Guide* for more information.

**Prerequisites**

- Set up resources and assign a track mode of “Time”. Resources require entering hours worked into their timesheet in CA Clarity PPM for the time period specified.
- To use the OBS Unit parameter to filter the report, add at least one OBS to the system. In addition, assign an OBS unit to the programs or projects.
Parameters

From Period
Defines the beginning of the effective date range for the report. To select a specific end date, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date, select the Relative Date option. Then, select the relative date from the drop-down list.

Resource OBS
Indicates the OBS unit to filter the report. Click the Browse icon and select the OBS from the list.

Project Manager
Indicates the managers whose projects require reporting.

Resource Name
Indicates the names of the resources to include on the report.

To Period
Defines the end of the effective date range for the report. To select a specific day, select the Specific Date option and type a date in the text field in the mm/dd/yyyy format. Or, click the Date Picker to select a day from the calendar that displays. To select a relative date, select the Relative Date option. Then, select the relative date from the drop-down list.

Report Fields

Hours
Displays in hours that a resource works.

Database Tables and Columns:
prj_blb_slices.slice

Manager
Displays the name of the manager whose projects are being reported.

Database Tables and Columns:
nbi_project_current_facts.manager_last_name
nbi_project_current_facts.manager_first_name

Note Category
Displays a category for the note. For example, Project or Personal.

Database Tables and Columns:
prnote.prcategory
Note Description

Displays the contents of the note.

Database Tables and Columns:
prnote.prvalue

Project Name

Displays the name of project to generate a report.

Database Tables and Columns:
nbi_project_current_facts.project_name

Resource ID

Displays the unique identifier for the resource.

Database Tables and Columns:
srm_resources.id

Resource Name

Displays the resource being reported.

Database Tables and Columns:
nbi_resource_facts.full_name

Status

Displays the status of the timesheet for the reporting time period.

Database Tables and Columns:
prtimesheet.prstatus

Task Name

Displays a project task being reported.

Database Tables and Columns:
prtask.prname

Time Period

Displays the reporting time period with missed time for the resource. It indicates the start and end dates of the time period.

Database Tables and Columns:
prtimeperiod.prstart
prtimeperiod.prfinish - 1
Appendix C: Access Rights

This section contains the following topics:

- **Audit Trail Access Rights** (see page 153)
- **Basic User Group Access Rights** (see page 153)
- **Dashboard Access Rights** (see page 154)
- **Reports Access Rights** (see page 154)
- **Software Download Access Rights** (see page 155)
- **Timesheets Access Rights** (see page 155)

**Audit Trail Access Rights**

The following access rights are available for audit:

- **Audit Trail - Access**
  - Allows users to access audit page.
  - **Type:** Global

- **Audit Trail - View - All**
  - Allows users to view any audit page.
  - **Type:** Global

**Basic User Group Access Rights**

The following access rights are provided by the default user group, **Basic Group for User Access**:

- **Account Settings - Navigate**
  - Lets the user navigate to the Account Settings page.
  - **Type:** Global

- **Organizer - Access**
  - Lets the user access the Organizer page and the Actions, Events, and Notifications portlets available from the Organizer page.
  - **Type:** Global

- **Projects - Navigate**
  - Lets the user navigate to the Projects list page and to the My Projects portlet.
  - **Type:** Global
Dashboard Access Rights

The following access rights are available for dashboards:

**Dashboard - Create**

Allows users to create new dashboards from CA Clarity PPM.

**Type:** Global

**Dashboard - Navigate**

Allows users to navigate to any dashboard page in CA Clarity PPM.

**Type:** Global

Reports Access Rights

The following access rights are available for users who run and review reports:

**Reports - Access**

Allows users to access reports pages. Additional report rights are also required to view, edit, or run reports.

**Type:** Global

**Reports - Run - All**

Allows you to run any report. This right also allows users to schedule, edit properties, and view the output of any report. The access is dependent on being granted Reports - Access right.

**Type:** Global

**Report - Run**

Allows users to run specific reports, edit properties and review output.

**Requires:** Reports - Access right

**Type:** Instance

**Reports - View Output - All**

Allows users to view the output of any report.

**Requires:** Reports - Access right

**Type:** Global
Software Download Access Rights

The following access rights are available for downloading software:

**Software Download - Microsoft Project Interface**
- Allows users to download the CA Clarity PPM Microsoft Project Interface.
  **Type:** Global

**Software Download - Open Workbench**
- Required to download Open Workbench.
  **Type:** Global

**Software Download - Xcelsius**
- Required to download Xcelsius.
  **Type:** Global

**Software Download - SVG Viewer**
- Required to download the SVG viewer.
  **Type:** Global

Timesheets Access Rights

The following access rights are available for timesheets:

**Timesheets - Navigate**
- Allows you to navigate to timesheet pages.
  **Type:** Global

**Timesheets - Edit All**
- Allows users to edit all timesheets.
  **Type:** Global

**Timesheets - Approve All**
- Allows users to approve all submitted timesheets.
  **Type:** Global

**Resource - Enter Time**
- Allows users to complete and submit timesheets for a specific resource.
  **Type:** Instance
**Project - Edit Project Plan**

Allows users to add unplanned tasks to a specific project when completing their timesheets when they are a team member on the project.

**Type:** Instance